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Overview

ACR®, Assure DQ® and ER® are used to verify the integrity of business
information. Infogix Insight® is used to monitor Assure DQ® and ACR® control
executions and exceptions.

ACR®, Assure DQ®, and ER® process results are stored in Infogix databases.
Perceive® extracts data from the Infogix databases and loads the data to the
following targets:

A Perceive database

A External database
A Flat file

Perceive® has two components: the Data Management interface and the
Reports interface.

Data Management Interface:

To create and manage reports based on ACR®, Assure DQ®, or ER® data, you
create a data entity, select outputs, map to reference data, relate to other data
entities, and extract and load data in the Data Management interface. In the
Reports interface, you create, edit, and view reports based on the data extracted.

To create and manage reports based on Infogix Insight® data, you establish a
source system and create a data view that references the source system in the
Data Management interface. In the Reports interface, you create, edit, and
view reports based on the data accessed.

Reports Interface:

The Reports interface includes features that support:

A Create new reports using an intuitive web -based drag -and -drop interface.
A Manage multiple reports efficiently and securely.
A Arrange reports and web content to create appealing, data -rich

dashboards that quickly convey business trends.

The Reports interface and the Data Management interface are integrated
to work together.

For example, when a data view is created in the data management
component, it communicates with the reporting component to:
A Create Data Domains.

A Create appropriate Starter Reports.

A Assign security to data.




Purpose of This Guide

The Reports User Guide
DataView Admin,

is intended

for users who are
Report Writer, or Report Viewer role in Perceive, and

in an Administrator,

concentrates on the Reports interface of Perceive.

Role Access to Data | Access to | Responsibilities
Management Report
interface interface

DataView Yes Yes A Create and edit domains.

Admin

Report No Yes A Create and edit Ad Hoc views.

Writer " .

A Create and edit reports.
A Create and edit dashboards.

Report No Yes A Runreports and dashboards.

Viewer - )

A View  report outputs and
dashboards.

Administrator | Yes Yes A Perform all actions in the
Report Interface except
managing server settings, users,
and roles.

The purpose of this guide isto provide information on the following topics:

A Scheduling reports and managing report resources in the Data

Management interface

> >» >» I>» >

Working with dashboards

Working with the Ad Hoc View

Creating and editing domains

Running reports and viewing report outputs

Adding reports directly to the Repository

The Getting Started for Reports guide is intended for users who are in a Report
Viewer or Report Writer role in Perceive. It provides basic information about
Perceive and about using the Reports interface specifically.
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Perceive Licenses

Perceive® can be licensed with or without the Reports interface. It can also be
licensed with or without the internal Perceive database. Thisguide assumes that
your organization is licensed for the Reports interface and for the internal

database. If your organization does not have a Reports license, you will not
have access tothe options described in this guide.

Running Reports from the Command Line

A Superuser or any user who has the access permission to the report can use
the runreport command line utility to run reports. Schedule one or more reports
to run simultaneously, and specify different parameters for the same report.

For more information on how to use the runreport command line utility, refer
the Perceive Ad mi ni s tGuidet.or 0 s

Accessing Perceive Using Infogix Insight

If your company is licensed for Infogix Insight®, you can access Perceive®
through the Infogix Insight® application. Through Infogix Insight®, you can view
Perceive® reports, report lists, and report repository, and you can log on to
Perceive® with a single sign on. For more information on how to access
Perceive using Infogix Insight, refer the Infogix Insight guide entitled Getting
Started with Views.

Scheduling Reports

Reports to view the data can be created in the Reports interface or in the stand -
alone application Studio. Scheduling reports to run is handled in the Data
Management interface. A Report Event is set up to run multiple reports based
on a schedule calendar or when the system detects that extracted data has
been loaded into the internal database. You define a report event once and
use it to run reports to meet your requirements.

For more information on scheduling reports, see the Help topic Scheduling Reports.




Managing Report Resources

Report resources can be exported from one Perceive installation and imported
into another. It is possible to export/import reports or specific resources both
from the Data Managementinterface  as well as from the Reports interface.

Report resources management is handled in the Data Management interface.
You can choose to export all report resources; report resources contained
within particular folders; or specific resources, such as one or more reports,
report outputs, dashboards, domains, and data sources. Toexport/import reports
or specific resources from the Data Management interface, you must set the
ENABLE_REPORT_RESOURCES_ MENbOperty as Truein the IV.properties file.

For more information on exporting and importing Repository resources, see the Help
topic Exporting and Importing Repository Resources




Getting Started in the Reports Interface

The following sections explain how to log in to the Reports Interface of
Perceive®, how to use the menu options, and how to navigate the Repository.

Logging In

Your user ID determines which interface you view when you log in to
Perceive®.

Tolog in to Perceive®, complete  the following steps:
1. Open a browser window.

2. Inthe address box, enter http://hostname:port/infogixperceive where
hostname is the name of the computer where Perceive isinstalled.

The Log In page displays.
Specify a UserID and Password.

4. If the option isavailable, select the Remember My User ID check box if you
want Perceive® to remember your UserID when you log in the next time.

5. Click Login.
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WINFOGIX

PERCEIVE

User ID |

Password |

[] rRemember My User ID

© 2005-2019 Infogix, Inc. All rights reserved.

Confidential - Limited distribution to authorized persons only, pursuant
to the terms of Infogix, Inc. license agreement. This software is
protected as an unpublished work and constitutes a trade secret of
Infegix, Inc.

Note: If you have used AuthO to configure the usersin LDAP, you need to
log in again to the Reports Interface using AuthO credentials when you
navigate to the




Reports Interface from the Data Management

Interface. Thisis required only the

first time until you log out of the session. The below isa sample screenshot of the

AuthO login screen for both Data Management Interface

The Get Started with Perceive screen displays.

Jacha
X
Log in

Email / Username

8

Password

&

©

and Reports Interface:

Infogix Perceive  New  Manage View Window Help

Get Started X

Get Started with Infogix Perceive

What would you like to do?

Manage Source Systems
Manage Data Entities
Manage Reference Data
Manage Data Views
Manage Reports

Learn about the interface

Version 9.2

£ 2010-2019 Infogix, Inc. All rights reserved

WINFOGIX

PERCEIVE

6. Click Manage Reports link or Manage > Reports.

The landing page specific to a user or a user based Dashboard that isset appears.

By default, the Reports Interface landing screen appears.
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To set a dashboard as the landing screen, click the Dashboard picker icon from the
User Preferences screen in the Data Management Interface. The list of Dashboards
for which the user has permission displays. Select the required Dashboard, click

Select and then Save. The configured dashboard appears as the landing creen
when you nhavigate tothe Reports Interface.

Infogix Perceive New Manage View Window Help

Get Started = User Preferences *

k2 ) Reset Password @ Help

User Preferences

Font Size Medium |«

/" )

Email Notification |«] Process Succeeded
(]

Process Failed

Report Home Page | /Infogix/Admin/ProcessMonitoring/ProcessDashboard

Note : Superuser or Administrator can configure a default dashboard for users
or groups in the Data Management Interface. The dashboard configured at

the user level takes precedence over the dashboard configured by the
Superuser or Administrator.

The below screenshot is an example of how the Reports Interface default landing
screen is displayed for an Admin user when no dashboard is set in the User
Preferences or no default dashboard issetby the Superuser or Administrator.
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=i| | N F O gntl:[ﬁ #& Library QuickLinks View~ Manage+ Create

Home

Data Sources
Define connection to a database or other
data source.

Create View list

Ad Hoc Views

y Visualize your data for analysis and report

creation.

Create View list

Dashboards

Combine related reports into custom
dashboard layouts.

Create View list

admin | Log Out

Domains
Add structure to a data source for use in an
Ad Hoc view.

Create View list

Reports

Create and format interactive reports from
existing Ad Hoc views.

Create View list

~ Admin

Configure your server instance.

w View options

The below screenshot isan example of how the Reports interface landing
screen is displayed for an Admin user when a dashboard

Preferences.

isset in User




=i| INFO G I X A& Llibrary Quick Links View+ Managev Create~ admin | Log Out

PERCEIVE

ProcessDashboard

2014-11-22 & 2015-11-22 E All Q

DashBoardReport

HINFOGIX
Process Dashboard

Data Extract Process

Completed, 49

Failed, 3

Resolved, 4

* Start Date * End Date * Process Type m
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Home Page Menu

The following table describes the menu options available in the Reports
Interface  Home Page.

Menu Option Description

Home For Administrators, DataView Admins, Report Writers, and
Report Viewers, it displays the Data Management Interface
Home Page.

Library Displays a pared-down Repository page that contains the Ad

Hoc Views, reports, and dashboards for which the currently
logged-in user hasrights (permissions required).

Quick Links Displaysthe default Reports Interface landing screen.




Menu Option

Description

View > SearchResults

Displays results of searches and filters. Use this page to
search all resources in the Repository. Narrow the list of
resources using the following types of filters:

A All available
A All types

A Anytime

A AnySchedule

View > Repository

Displaysthe Re p o s i foldersy fports, and content files
(created when a report is run in the background or through a
report event in the Data Managementinterface).

For Administrators and DataView Admins, this list includes
types of object such as data sources, images, data types,
queries, Ad Hoc View, and input controls.

For Report Writers, this list includes data views and reports
to which they have permission.

For Report Viewers, this list includes reports and report
outputs to which they have permission.

View > Reports

Displaysa list of reports for which Report Viewers and Report
Writers have permission to view and run.

View > Messages

Displaysthe messagesthrown by the system. For example, if
the report scheduler failed due to an error, the messagewill
be shown in this tab with a type Error. Accessible for the
admin roles.

Manage> Users

Displaysthe list of the userswho have logged into the Reports
interface. It displays user properties such as User name,
User ID, Roles Assigned, and Profile Attributes. To delete
a user, select the user and click Delete.

Manage> Roles

Displaysthe list of default roles and their properties.

Manage> Server Settings

For Administrators, it contains option like clear adhoc cache,
setting the row numbers for the adhoc report etc.

Create > Ad Hoc View

For Report Writers, it creates an Ad Hoc View.

Create > Report

For Report Writers, Admin, it creates an Ad Hoc report from
Ad Hoc View.

Create > Dashboard

For Administrators and DataView Admins, it creates a
dashboard.

Create > Domain

For Administrators, it creates a domain.

Create > Data Source

For Administrators, it creates a datasource.

16




Library

On clicking the Library option from the Menu bar, the Library page displays as
shown below:

MINFO gml:zﬁ # Llbrary Quicklinks Views Manage- Create~ admin | Log Out
Library Sort By: Name | Modified Date
Name Description Type Created Date Modified Date A
1 Report 11/12/2015 11/12/2015
Ad Hoc View Ad Hoc View 11/6/2015 11/6/2015
Ad Hoc View Ad Hoc View 11/13/2015 11/13/2015
Ad Hoc View Report Report 11/6/2015
Ad Hoc View Report Report 11/10/2015
Ad Hoc View Report Report 11/10/2015
Ad Hoc View Report Report 11/13/2015
Aging Unresolved Report List all the failed processes older than certain days Report 11/5/2015
Archived Audit Report All events report Report 11/5/2015
Archived Audit Report Adhoc Data View The AdhocDataView for Archived Audit Report report Ad Hoc View 11/5/2015
Daily Item Summary by Work Owner Daily Item Summary by Work Owner Report 11/13/2015
Daily Item Summary by Work Owner Daily Item Summary by Work Owner Report 11/13/2015
Daily Item Summary by Work Owner Daily Item Summary by Work Owner Report 11/16/2015
Daily Matched Items Daily Matched Items Report 11/12/2015
Daily Matched Items Daily Matched Items Report 11/12/2015 v
it Mt hod Thome it Matehed Thome Renort 11110 111aroms
Copyright © Infogix, Inc.

You can sort the components either by name or by the modified date. It
is also possible to search for an elementin the search field by entering a part of
the name.

The following table describes the different columns in the Library page for
which the logged in user has the permission.

Column Description
Name Displaysthe component nhame.
Description Displaysthe description of the component.

Type Displaysthe type of the component.

Created Date

Displaysthe date when the component was created.

Modified Date Displaysthe date when the component was last modified.

Repository

The Repository isthe directory for all reports -related files. The Repository maintains
links to the files and provides ways to access them irrespective of where the
reports are stored on the computer or network.

17




The available menu options are determined by the selected object,

Toview the Repository, complete the following steps:
1. Onthe Home Page, click View > Repository .

>

>

A

The actions that a user can perform in the Repository depend onthe us er 6 s

role and the permission that is set.

The Data View folder and its contents that a user can accessdepend on the

security profile associatedwith that data view and the permission.

The Repository page displays.

IilINFOﬁ. X & tbay Quiklinks Views Manage. Creates admin | Log Out Q

il Folders

Sl root

=l Infogix

: wl Common
5l DataSources
{5l Dataviews
5l DataCheck_DV_Nov10
&l DataDomains
{5l Entities
5l DATACHECK_DE_NOV10
{5l DataDomains
(34 pE_DV_Datefield
[l Domain_Reports
Jul Organizations

ublic

Wl Temp

&
=
#
&

o Themes

Repository

Name

DashBoard_Nov16
DashBoardReports
ChartReport
IVP_3014_NEW

RE1_Test
Datacheck_DV_Nov10.pdf
Datacheck_DV_Nov10
Dashboard

LinkedReports

Description

Type
Dashboard
Report
Report
Report

Report

Content Resource

Report
Dashboard

Report

Sort By: Name | Modified Date

Created Date Modified Date

11/16/2015 11/16/2015
11/10/2015 11/16/2015
11/16/2015 11/16/2015
11/16/2015 11/16/2015
11/10/2015 11/10/2015
11/10/2015 11/10/2015
11/10/2015 11/10/2015
11/10/2015 11/10/2015
11/10/2015 11/10/2015

Copyright © Infogix, Inc.

In the Navigation pane, expand a folder to display its contents.

In the Navigation pane, select a folder or an object to view details in

the Content pane.

Perform one of the following operation:

In the Content pane, highlight an object and then click one of the icons

at the top of the pane to perform an operation on the object.

In the Content pane,
the context menu.

In the Navigation
from the context menu.

pane,

right-click an objectand selectan operation from

right-click a folder and select an operation

the user s

role, and the permission. Some menu options are available on the context
menu when you right-click an object.

18




The following table explains the different menu options.

Menu Option

Description

Add Folder

Inserts a folder in the folder selected in the
Navigation pane.

Add Resource

Displays the Add Resource menu, where you select
the resource type to add. When you select the type,
the appropriate page for adding the resource displays.

Copy

Makesa copy of the selected object in another folder.
Select the 0 b j e chiedk ox, click Copy, right-click
the destination folder, and select Copy Here in the
context menu.

Cut

Copies the object selected with Copy into the
destination folder.

Delete

Deletes the selected object from the Repository.

Deleting an object that is used as a data
source might cause other dependent
objects, such as reports and Topics, to
fail.

Edit

Opensthe selected object in the appropriate editor.

Paste

Moves the selected object to another folder. Select
the o b j e chedksbox, click ve, right-click the
destination folder, and clicldzove Here in the
context menu.

Open

Runs the selected report and displays the report
results in a new browser window.

Openin Designer

Opensthe selected object in the component in which
it was designed. Reports created in the Ad Hoc Editor
open in the Designer; Topics savedfrom Domains open
in the Edit Domain Topic wizard. You can edit the
object and savethe changes.

Permissions Set the permission for the Repository objects at the
user or role level.

Properties Opens the Resource Properties window, which
displaysthe o b j e basi@psoperties.

Run Runsthe selected report.

Runin New Tab

Runsthe selected report in a different browser.

Export

Exports the selected report asa zip file.

Hint: You can drag a Repository object over a folder and drop it to move itto a
new location.

Reports can be retained

in the Repository based on the value set in the

REPORT_RETENTION_POLICY_DAY®perty. Report Repository can be cleaned up

19




and the reports can be archived. By default, the reports are stored in the Repository
for 90 days. The location to archive the generated reports can be specified in
the REPORT_ARCHIVE_HOMIgroperty.

Repository Permissions
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Repository permissions on folders and resources determine what you see in the
Repository and what actions you are allowed to perform. Permissions apply
when browsing or searching the Repository, as well as when using any dialog
that accesses the Repository, such as when browsing folders to save a report.
Permissions can be role-based or user-based.

In the following table, the actions granted for each permission include all of
the actions granted for permissions above it, except for the No Access
permission. The actions granted for each permission strictly exclude all the actions
granted for permissions below it.

Permission Option Description

No Access Users can never see or accessthe folder or resource
either directly in the Repository or indirectly when
running a report or a dashboard.

Execute Only Users can run the reports and dashboardsto accessa
resource, but the resources are not displayed in the
Repository.

ReadOnly Users can view the folder or resource and their

properties. They can run a report or a dashboard,
copy a folder and all of its readable contents, and

COpy resources.
Read+ Write Userscan run and create report or a dashboard.
Read+ Delete Userscan cut and delete a folder and its contents and
resources.
Read+ Write + Delete Users can add a sub folder and paste the copied/cut

folder or resource into a folder. They can save a new
Ad Hoc View, Report, or Dashboardin a folder. They
can rename a folder or a resource and change its
description. They can open an Ad Hoc View in the Ad
Hoc Editor or a dashboard in a designer. They can
modify and overwrite an existing Ad Hoc View,
report, or a dashboard.

Administer Userscan set the permissions (by role and by user) on
a folder or resource. This effectively delegates
certain Repository administration tasks.
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Note: If you have data or sensitive content in a resource, always set No
Access
permission for usersor roles that must not be able to access it.

Hiding a resource with Execute Only permission does not protect against
access, because malicious userswho find the resource ID may be able to create
a report or a dashboard that extracts the sensitive content.

Inheriting Permissions

According to the permission architecture, there is a permission setting for every
user and role on every folder and resource in the Repository. Perceive supports
the inheritance of permissions from the parent folder of a folder or resource.
If no permission is explicity defined for a user or role on a given folder or
resource, the user or role has the same access permission that isdefined on the
parent folder. When permission is defined explicitly, that permission is enforced,
regardless of those on the parent folder.

Because permissions can be assigned to both users and roles, a user belonging
to one or more roles may have multiple permissions defined or inherited on any
given folder

or resource. In fact, every permission must be defined on the root, even if it has
the default value of No Access, and therefore every role- and user-based
permission on every folder and resource has a setting through inheritance.
Therefore, for every folder or resource, every user has their own user-based
permission and the permission assigned tothe ROLE_USER.

Permissions are strictly cumulative, meaning that the least restrictive among the
set of all permission applies. Even if a more restrictive permission, such as No
Access, is set explicitly, the less restrictive permission such as Read -Only applies,
regardless of whether itisinherited or set explicitly.

Note : Permission for the ROLE_USERor any new Data Views created under the
Data Views folder is 'No Access' irrespective of the permission set at the Data
Views folder level.Superuser or Administrator must explicitty set the required
permission for the ROLE_USER ithe new Data View folder.

Setting Permissions

Administrators can assign permissions to access any folder or resource throughout

the Repository. Users with the Administer permission on a folder can assign
permissions to that folder and any contents that inherit the permission. Users
granted Administer permission to a resource can only set the permissions on that
specific resource.

To set permission on a folder or a resource, complete the following steps.




1. Log into the Reports Interface as an Administrator.
2. Navigate to the required folder orresource in the Repository.

3. Right-click the folder or resource and click Permissions.

MINFOGIX & ubay

PERCEIVE
© Folders
|§|_j root
El_j Infogix
Admin
Common
DataSources
DataViews
Organizations Add Folder

Public Add Resource
Temp
o Copy
Themes
Cut
Delets
Properties...
Export

The Permissions dialog appears. It displays the permissions in effect for the selected
object. By default, it displays the permissions given to roles. Permissions that are
inherited from the o b j e @dredts are indicated by an asterisk (*).

4. Click the drop -down next to each role to set the required permission.
Select the required permission and click Apply .
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Permissions: /Infogix/DataViews

View by: User | Role

Mo Access |
ROLE_ADMINISTRATOR Administer *

Read Only
ROLE_DATAVIEW_ADMIN Read + Write

Read + De!ete
ROLE_REPORT_VIEWER Read + Write + Delete

Execute Only
ROLE_REPORT_WRITER Mo Access * hd
ROLE_SUPERUSER e
ROLE_USER [read Only * ~

Apply oK Cancel

5. Click the Usertab to set permission to different users.

6. Click the drop -down next to each user to set the required permission. Select
the required permission and click Apply . If you toggle between user and
role permissions, you must click Apply firstto save any changes you made.

7. Click OK after the permission isset for both role and user.

Permissions: /Infogix/DataViews

View by: User | Role

admin v

AWl Mo Access *

I¥_admin

Read + Write
Read + Delete
Read + Write + Delete

Execute Only

Apply 0K Cancel

A

8. Log out and log into the Reports interface to view the updated
Repository structure as per the permission set for the user and role.

Note : There are two special cases when setting permissions:

9 If a resource inherits a permission, for example Read-Only, you cannot set
the permission to the same value, at least not directly. You need to
temporarily change the permission level on the parent folder, then set the
explicit permission, then set the par ent f permidseom dagk to the
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original value.

When a resource and its parent folder have been set to the same
permission in this way, the permission dialog still shows the asterisk as if the
permission were inherited. But when the parent is later given a different
permission, for example Read -Write, the resource retains its explicit Read -
Only permission instead of inheriting Read -Write.

To reset the permission level so that it once more inherits from its parent
folder, select a different permissions level and click Apply , then select
the permission with the asterisk and click Apply again.
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Working with Dashboards

A dashboard can display several reports in a single, integrated view. A dashboard
can also include filters (that determine the data displayed in one or more
dashlets), other dashboards, and custom dashlets that point to URLsto any other
content. By combining different types of related content, you can create
appealing, data -rich dashboards that quickly convey trends.

The following example isa sample dashboard.

MINFOG | X

FERCEIVE Library Quick Links View~ Manage+ Createv

Dashboard Viewer

IINFOGIX

Employee Details Report Department Details

Employee Basic Details GEO ,2- _Eng 4

HIST ,2-
Math ,5—

Employee Details Filterd

Employee Details Formatted Based on %

—SCIENCE ,2

Employee Details Formatted POLTICAL ,2

[m -45K USI 100K USD-1MUS 5001k USD-99.959K UsD |

Thischapter contains the following topics:

A Overview of Dashboard Designer
A Viewing a Dashboard

A Creating a Dashboard

A Specifying Parameters in Dashlet
A Editing a Dashboard




Overview of Dashboard Designer

The Dashboard Designer isa web -based Ul for embedding reports and Ad Hoc
Views into a single, interactive space. You can compile dashboards that include
pre -existing elements, such as reports and views, and create new charts, tables,
and crosstabs from your data sources directly from the designer.

Each element on your dashboard is called a Dashlet. Dashlets have unique

names and resource IDs, and editable properties that vary depending on the
Dashlet type.

Your permissions to access the Repository may limit the content you can add
and the location where you can save the dashboard.

Dashboard Designer Interface
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A u s e pebrassions in the Reports interface may limit the content they can add
and the location where they can save the dashboard.

The below screenshot displays the basic layout of the Dashboard Designer.

The Dashboard Designer Ulincludes the following panels:

A Available Content: You can drag content onto the Dashboard Canvas.
Thispanel includes the following sections:

o New Content: Liststhe content elements you can create for your
dashboard.

o Existing Content: Liststhe Ad Hoc Views and reports you can access
from the Repository.




o Filters: Listsall filters associated with any resource added tothe dashboard.
A Toolbar Buttons

A Dashboard Canvas: Thisiswhere you create and edit your dashboard. It
includes the following sections:

o Title Bar: Displays the name of the dashboard (in the figure above, the
name is "New Dashboard").

0 Main Creation Area: Area where you build your dashboard. Drag
elements from the Available Content panel to get started.

The following table explains the different Toolbar Buttons:

Icon Name Description
ﬂ Preview Click to display current dashboard as viewed by
the end user.
El Save/SaveAs Hover cursor over icon to open a menu of save
i options.
. Undo Click to undo the most recent action.
| _®F
P Redo Click to redo the most recent undone action.
Undo All Click to revert the dashboard to the most

recently savedstate.

T‘ Filter Manager Click to open the Filter Manager.
gﬂ DashboardProperties | Click to open the DashboardProperties box.
Show/Hide Grid Click to display or hide a grid.

Dashlets and Dashboard Elements

Each elementadded to your dashboard iscalled a dashlet.

Toadd a dashlet to your dashboard, simply select a content element and drag
it onto the dashboard canvas. Dashlets can include the following elements,
which you can access from the Available Content panel:

A New Content:
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Chart: Allows you to create a chart within the Dashboard Designer.
Crosstab: Allows you to create a crosstab within the Dashboard Designer.
Table: Allows you to create a table within the Dashboard Designer.

Text: A free-form text entry field. Use free text items to add titles
and instructional textto the dashboard.

Web Page: Any URLaddressable web content. The dashboard can point
to web content. For example, you might include a dashlet that points to
the logo on your corporate website; when that logo changes, the
dashboard automatically updates to reflectthe branding change.

Image: Allows you to add an image from the repository or from a web
address.

Existing Content: Reports and Ad Hoc Views for which you have permission.

Filters: If a report you include on the dashboard is designed to use input
controls or filters, you can add that capabilty to the dashboard. The server
maps input controls to one or more dashlets. Controls can also be manually
mapped to custom URLdashlets.

Title Bar: You can enable a title bar in the Dashlet Properties dialog box. The
titte bar includes the Dashlet name (as entered in the Dashlet properties)

and the Dashlet toolbar which contains the Maximize (") and Refresh ()
icons.

(0]

(0]

Maximize: Click to open the dashlet as a larger view.
Refresh: Click to refresh the dashlet.

Dashboard Properties

You can view and edit the basic appearance of all dashlets on your
dashboard and determine the refresh settings through the Dashboard
Properties.
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To view and editthe Dashboard properties, complete the following steps:

1. On the dashboard toolbar, cli@ to open the Dashboard Properties window:
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Dashboard Properties

Canvas Settings:

Background Color: v

Set custom size in pixels: by

Dashlet Settings:

Show Filter Dashlet as pop-up window
# Show borders

Quter margin in pixels: 5

Inner padding in pixels: 5

Title bar text color: _ v

Title bar background color: v
Toolbar Settings:

Show Export button

Refresh Settings:

Auto-refresh dashboard contents

Refresh Interval:

Edit the Canvas Settings as per the requirement:

A
A

Background Color: Select the background color for the dashboard.

Set custom sizein pixels: Set the customize sizeof the dashboard in pixels.

Edit the Dashlet Settings as per the requirement:

>

> >

>

> >

Show Filter Dashlet as pop -up window: Select this option to display the
dashlet containing filter in a separate pop -up window.

Show borders: Select this option to display the border for dashlets.

Outer margin in pixels: Enter the desired width, in pixels, of the
margins between dashlet.

Inner padding in pixels: Enter the desired width, in pixels, of the padding
inside each dashlet.

Title bar text color: Select the color for the title bar text.
Title bar background color: Select the background color for the title bar.

Select the export option in the toolbar settings to export the dashboard
to different formats. When using the custom visualization component,
PhantomJS must be installed separately. The location of PhantomJS
application must be specified in the PATH_TO_PHANTOM_JSroperty in
the IV.properties file. PhantomJS is available at http://phantomjs.org/ for



http://phantomjs.org/

all major Operating Systems.

4. Editthe Refresh Settings as per the requirement:

A Auto -refresh dashboard contents: Select or deselect this to enable or

disable automatic

Refresh Interval:
content refresh,

refresh for your content.

Enter the number of minutes or seconds between each
using the text entry and drop -down menu.

Dashlet Properties

You can view and
on your dashboard
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create

parameters

available properties

To view and edit the

1.

edit basic information and appearance for each dashlet
using the Dashlet properties. For some dashlets, you can also
which you can then map to in the filter manager. The
vary based on the type of dashletyou are working with.

Dashlet properties, complete the following steps:

Right-click on the dashlet and select Properties to open the Dashlet
Properties window.

Click Apply to view the changes, OK to accept the changes, and Cancel to
discard the changes.

Dashlet Properties

Dashlet Name:

http://google.com

Resource ID:
Web_Page

Web Page Address (URL):

http://google.com

Show/Hide Dashlet Elements:
¥ show title bar
Show refresh button
¥ show maximize button

¥ show scroll bars

Refresh Settings:

Refresh Interval:

=3 -

Cancel

Auto-refresh dashlet contents

Properties for Dashlets containing Crosstabs, Tables, Reports, and Ad Hoc
Views (excluding Chart Ad Hoc Views) include:
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> >» >» >

)

Dashlet Name: Editable field for the displayed dashlet name
Resource ID: Non-editable ID taken from the original dashlet name
Source Data: Non-editable path of the source data

Show/Hide Dashlet elements: Select or deselect to show or hide the title
bar, which includes the dashlet name, refresh button, maximize button, and
export option.

Scale to Fit: Use the drop -down menu to determine how the element isscaled
in the dashlet

Refresh Settings: Select or deselect to enable or disable auto -refresh, and use
the text entry and drop -down menu to set the time between each content
refresh. Thissetting overrides refresh properties set at the dashboard level.

Dashlet Properties

Properties on the Hyperlink tab for Dashlets containing charts, text, and
image include:

A

A

>

Enable object hyperlinks: Select or deselectto enable a hyperlink for the
dashlet.

Action: Select link behavior for this dashlet.

0 Update page: Select this option to update dashlets linked to this one
when a user clicks on a data pointin the object.

o Open new page: Select this to have the dashlet open a web page or
report, dashboard, or an Ad Hoc View in the Repository when a user
clicks on the dashlet.

0 Replace page: Select this to have the dashlet replaced with a web
page or report, dashboard, or an Ad Hoc View in the Repository when a
user clicks on the dashlet.

Parameters: When you add a parameter, use a name in this listto have the
filter manager create the link to the parameter automatically. When you
add a parameter, click Map Parameters to save and close the Dashlet
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Properties window and open the filter manager.

Dashlet Properties

Basic Hyperlinks

Image Hyperlinks:
¥ Enable image hyperlinks
Action:
Update page A
Update page
Open new page
Pard Replace page

Name Value

Map Parameters...

Properties for Dashlets containing text include three tabs:

A

A
A

>

>

Dashlet Name: Editable field or the displayed dashlet name

Resource ID: Non -editable

ID taken from the original dashlet name

Text: Editable field for the text displayed in the dashlet

Dashlet Properties

Dashlet Name:

Basic Formatting Hyperlinks

Text

Resource ID:
Text

Text:

Text_Dashlet

m OK Cancel

Text Formatting: Usethe selection listsand buttons to set the font, font size, font
style, alignment, and font color and background color for the text displayed in
the dashlet. Use the drop -down menu to determine how the element is

scaled in the dashlet

Dashlet Formatting: Usethe selection to display the border for the dashlet
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Dashlet Properties
Basic Formatting Hyperlinks
-

Text Formatting:

Scale to Fit:

None v

Font: Size: Style:

Arial 12 B [ |U

Arial & alignment:

Arial Black 9 T -

Arial Narrow 10 = = =

Courier 11 —

Courier New 12 | ;

Georgia 14

Tahoma 15

Times New Roman 18 Background Color:

Verdana 20 -

22
T
Text Color:
I -

Dashlet Formatting:

# Show borders -

-
m oK Cancel

Properties for dashlets containing a Web Page include:

> >» >» >

> >

Dashlet Name: Editable field for the displayed dashlet name
Resource ID: Non-editable ID taken from the original dashlet name
Web Page Address (URL):Editable field for the URL displayed in the dashlet

Show/Hide Dashlet elements: Select or deselect to show or hide the title
bar, which includes the dashlet name, refresh button, and maximize button

Show scroll bars: Select or deselect to show or hide scroll bars

Refresh Settings: Select or deselect to enable or disable auto -refresh, and use
the text entry and drop - down menu to set the time between each content
refresh. Thissetting overrides refresh properties set at the dashboard level
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Dashlet Properties

Dashlet Name:

http://google.com

- Resource ID:
' Web_Page

Web Page Address (URL):

http://google.com

Show/Hide Dashlet Elements:
#| Show title bar
Show refresh button
#| Show maximize button
# Show scroll bars

Refresh Settings:
Auto-refresh dashlet contents

Refresh Interval:

Apply 0K Cancel

Properties for dashlets containing an Image include:

>

Dashlet Name: Editable field for the displayed dashlet name

>

Resource ID: Non-editable ID taken from the original dashlet name

>

Web Address/Repository URI:Enter the web address where the image is
located or browse from the Repository to select an image

>

Show/Hide Dashlet elements: Select or deselect to show or hide the title
bar, which includes the dashlet name, refresh button, and maximize button

>

Show borders: Usethe selection to display the border for the dashlet

>

Scale to Fit: Use the drop -down menu to determine how the element is
scaled in the dashlet




Dashlet Properties

Basic Hyperlinks

Dashlet Name:

Image

Resource ID:
Image

Web Address/Repository URI:

repo:/organizations/organization_1/themes/jasper_ Browse...

Show/Hide Dashlet Elements:
Show title bar
Show refresh button
Show maximize button

¥ Show borders

Border Color:

Scale to Fit:
Width v
-
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Properties for dashlets containing a filter include:

A Dashlet Name: Editable field for the displayed dashlet name

A Resource ID: Non-editable D taken from the original dashlet name

A Show/Hide Dashlet buttons: Select or deselect to show or hide the Apply
button or Reset button

A Position of dashlet buttons: Use the drop -down menu to select bottom or right
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Viewing a Dashboard

You can view an existing dashboard if you have the required permissions. By

default,

the Admin dashboard will be available in the following path:

root>Infogix>Admin>Proce
ssMonitoring.

Toview a dashboard,

complete the following steps:

1. Click View > Repository .

2.

3.

In the Navigation

folder list, locate and select the folder

containing the dashboards.

£ Folders
[=Jesl oot
Sl Infogix

Pl Common

E En En EHy @

Query

[#
[+

DataViews

2] =) |

Organizations

[+]

Fublic

H &

Temp

[#

Themes

[+]

EM Daczh_Bcards

DataSource
Images
InputControls
InputDataTypes

Marmada_lssues
DataSources
IReport_Report Testing

JasperStudio Report Ts

System Properties

In the Content pane,

click the name of a dashboard to

display it. The following isa sample dashboard.
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Dashboard Viewer

Prepared Date03/13/2014 2:00 AM

Aggregate Pass Rate - By Criticality (For duration - All)

Critical Elements

Non-critical Elements

< 1 m

Prepared Date 03/13/2014 2:00 AM

Aggregate Pass Rate By Dimension (For duration - All)

L

NINFOGIX

88

22

p ; ; ;
& o~ A A

R

L

r'{ S

r"l S

& . & .

| »

m

If one of the dashlets in a dashboard does not refer to a filter, that dashlet
does not update when you change that filter value. Only reports that refer to

the filter reflect the change.
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The following example displays a list of the dashboard content that is available
when you click New > Dashboard .

i Available Content

» New Content
gl chart

[E=| Crosstab

[E2| Table

TT| Text

& Web Page

+ Existing Content El

Q

Aging Unresolved Report
Archived Audit Report

Archived Audit Report A
Archived Performance C...
Archived Performance C...
Archived Performance R...
Archived Performance R...
Archived Repository Res..
Archived Repository Res...

Archived Resource Exec...

EV @ EY @ EY @ EY @ EY EY

Click to view the Existing Content in different views. The ListView is displayed
by default.
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MINFOGIX & by QuickLlinks

1 Available Content

v New Content
dll Chart

|E=] Crosstab

|E2| Table

17| Text

@ Web Page

v Existing Content

root
Public

New Dashboard

O H. <«

List View

Folder View

All

Reports
Ad Hoc Views

-

Managev Create~




Creating a Dashboard

Creating a Simple Dashboard using Existing Content

To add a report to a dashboard, you must have permission to view the report.

Tocreate a simple dashboard, complete the following steps:

1. Click New > Dashboard.

The Dashboard Designer displays a list of available content and the
dashboard designer area.

MINFO ﬁml::ﬁ A Lbrary Quicklinks Viewy Managev Create~ admin | Log Out Q

1 Available Content New Dashboard

v New Content © B. « » o Y & iz
il chart

[EZ| Crosstab

[ Table

TT) Text

@ Web Page

w Existing Content

Start building your dashboard:
« Drag an item from the Available Content panel onto
the canvas to create a dashlet.
Ad Hoc View * Use automatic placement or drag the edge of a
dashlet to resize it.
* Use the Properties button in the toolbar to set
Ad Hoc View Report dashboard-level properties.
Ad Hoc View Report * Double-click on a dashlet to edit its properties.
Right-click a dashlet to see all available options.

hs] 1

B Ad Hoc View

Ad Hoc View Report

El ED EV |

Aging Unresolved Report

[ED

Archived Audit Report
Archived Audit Report A

Archived Performance C

[ EY @ ED

Archived Performance C
Archived Performance R.
Archived Performance R.

Archived Repository Res.

EV EY [ EY

Daily Matched Items

) Daily Matched Items v

i E

=_Dailv Matched Ttems.

» Filters

Copyright @ Infogix, Inc.

2. In the Available Content list, you can create a dashboard dynamically using
one of the options in the New Content section or use the already existing
Report or Ad Hoc View in the Existing Content section.

In the below example, select one of the already existing reports. Drag and drop it
to the Dashboard Designer area.
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=i' l N F O G l x #A library Quick Links Views Managev Createv

PERCEIVE
£l Available Content New Dashboard
v New Content O 9 i @~ > O ) 4 °o B
dll Chart
|EZ| Crosstab
[EE Table
TT| Text

@ Web Page
v Existing Content B8

| Q]

[?3_1 root

Sl Infogix
[5_1 Admin
@4 ProcessMonitoring
é_l Reports
|| Aging Unresolved Report

E DashBoardReport

|im] ProcessDetails
| Unresolved Report
(Al AVIDEMO
[:1_; DataViews
@_4 Domain_Reports
F;u Organizations

&:L_A Public

The report displays in a dashlet in the upper left corner of the dashboard area.

To add another report to the dashboard, in the Available Content list, select

one of the options in the New Content or Exisithg Content sections, drag and
drop it to the Dashboard area.

Move your cursor over the bottom of right-hand edge of the dashlet
containing a report. When your cursor changes to a resizing icon (™), click
and drag the edge of the frame to resize it. Adjust the width and height of
the frame to display the defaultdata returned by the report.

Resizethe dashlet of any other reports to fit its width.

When the frames are sized for their reports, the dashboard may be wider than
the specified screen size.




lil . N F O gm'xﬁ #A Lbrary Quick Links View+ Managev Createv admin | Log Out
I Available Content New Dashboard
v New Content o E’ @« ~» O Y o° 222}
dll chart
[ Crosstab DashBoardReport
[ Table
{TE} Text Process Monitoring Dash-Board
@ Web Page Data Extract Process i | NFOG | x
: l

v Existing Content

Sl root
Gl 1nfogix Sormpicted, 33
Sl Admin

{5l ProcessMonitoring

(5l Reports

i Aging Unresolved Report

nnnnnnnnnnnnnnnn

sDetails

esolved Report
(Bl AVIDEMO
{Aal DataViews

)l Domain_Reports

{5l Organizations

{5l Public

v Filters

| DashBoardReport

7. Click o add a filter to the dashboard. If there are default filters in a Report
or Ad Hoc View, drag and drop them from the Filters section to the
Dashboard Designer area.

Clickto display or hide the dashboard properties dialog box.
9. Right-click the dashlet and click Properties to edit the dashlet properties.

10. Click to display or hide the grid lines.

11. Click to maximize or minimize the dashlet.
12. Click Save > Save Dashboard after designing the dashboard.

13. Navigate through the tree structure to the folder under which you will save
the dashboard, and specify a dashboard name.

14. Click Save. The dashboard issaved tothe Repository.

The following screenshot displays an example of a dashboard with filter.
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Creating a Dashboard using New Content

1. Click New > Dashboard.

The Dashboard Designer displays a list of available content and the dashboard
area.

2. Select one of the options in the New Content section. In this example, select a
Chart. Drag and drop it to the Dashboard Designer area.

=i| l N F O G ' x A Llibrary QuickLinks View+ Managev Create~
PERCEIVE
1 Available Content New Dashboard

v New Content © H. @~ ~»H D T % EH

|E=| Crosstab

|22 Table
[TT| Text
@ Web Page Start building your dashboard:
* Drag an item from the Available Content panel onto
the canvas to create a dashlet.
v Existing Content B e Use automatic placement or drag the edge of a
Q ’ dashlet to resize it.
* Use the Properties button in the toolbar to set
@ AUDIT of Running Reports dashboard-level properties.
e ~ ¢ Double-click on a dashlet to edit its properties.
{Z| AUDIT of Running Repor. Right-click a dashlet to see all available options.
|| Ad Hoc View
|=| Ad Hoc View
[ Ad Hoc View
|| Ad Hoc View
|Z= Ad Hoc View

Ad Har \iawr

3. Selectthe required data view domain and click Choose Data.
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Select Data

= H |

’i?‘_] CaseSummary
’i?‘_] ControlData
’i?‘_] ControlData

|_=|_] DB DataViewDomain

| ControlData

|_=|_] DB EMPTEST_DE InfogixDomain
’i?‘_] DEPT_DV123 DEPT_ InfogixDomain

’i?‘_] DE_Test_Oct27 DE_Test1 InfogixDomain
[T DE_Test_oct27 DataviewDamain

’i?‘_] DV_EMP.Recruit DataViewDomain

’i?‘_] DV_EMP.Recruit EMP_Recruit InfogixDomain
iy DV_ER_CLAIM DataViewDomain

’i?‘_] DV_ER_CLAIM ER_CLAIMPAYMENT All EOD Entities

DataViewDomain

Choose Data... Cancel

B DEPT_DV123 DataViewDomain

4. Selectthe required fields and click OK.

Data Chooser

Choose Data

Save as Topic

To move items in or out of selected fields, double-click them, drag them, or use the direction buttons.

Source Selected Fields

Control Data

« createTime

updateTime

processHistId
historyType
controlPoint
retentionClass
DepID

Dept_
Mo_0OFf_Teachers
Amount_of_Rupees
partitionkKey

IVP_CREATEDDATE

5. Selectthe required fields and measures. The Chart appears.
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6. Click Save to save the chart as a dashlet to the dashboard.
7. Enter a name for the dashlet and click Save.

8. The saved chart appears as a dashlet in the dashboard. Click Save
Dashboard to save the dashboard.

MINFOGIX a o uatie ven: tomme- crose-

Now Dashboard
8. «~0o Yo m

Yest Gragh




Adding Filtersto a Dashboard

If a report contains  a filter, you can add filter to the
dashboard. Toadd filters to a dashboard, complete the
following steps:

1. Locate the dashboard. Select the folder, right-click the dashboard in the
Content pane, and select Open in Designer .

The dashboard displays in the Dashboard Designer.

2. In the Available Content list, navigate to the Filters section. The filters
associated with the report are listed. Drag and drop the filter from the Filters
section to the Dashboard Designer area.

fIINFO % g‘ﬁ A Llbrary QuickLinks View+ Manage» Createw admin | Log Out
#1 Available Content New Dashboard
v New Content o Bv “« ~» O Y & B
il chart
|2 Crosstab * Start Date
[ Table 2014-11-23
'TT| Text
@® Web Page * End Date
v Existing Content B+ 2015-11-23
1 Q|
Gl root * Process Type
[@ Ad Hoc View Report_Nov06 2 [ Q

Ad Hoc View Sajith

Ad Hoc View_Nov06 -
Check

& @ A

Check_report

ED

DashBoardReport

‘;1,. Infogix
{5l Admin
{5l ProcessMonitoring :l I N FO G l X
{5l Reports P D h b d

[m Aging Unresolved R rocess as oar
@ ProcessDetails Data Extract Process
[@ Unresolved Report

(@@l DvA

Completed, 27

il DataViews
'ip Inhertance Test v -8
[#lal RV
v Filters
i) DashBoardReport
V Start Date
¥ End Date

¥ Process Type

The input control and its label display in the upper -left corner of the
dashboard area, nudging the report down to accommodate the new filter.

3. Right-click the Filter dashlet and click Properties .
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New Dashboard

© H, « » » Y & m

* Start Date

2014-11-23

* End Date

2015-11-23

* Process Type

All Q,

Delete

The Dashlet Properties pop -up box for the filter appears.

4. Dashlet properties such as the Dashlet name, the number of filters that
should appear per row, position and the display of Dashlet buttons can be
set.

Dashlet Properties

Dashlet Name:

Filter Group

Resource ID:
Filter_Group

Filters per row:

Show/Hide Dashlet Buttons:
¥ show Apply button
[] Show Reset button

Position of dashlet buttons:

bottom LY

5. The updated filter appears in the dashboard after the dashlet
properties are modified.




New Dashboard

OBv “« Yoo HH

* Start Date * End Date * Process Type -

2014-11-23 B 2015-11-23 E all Q

DashBoardReport

HINFOGIX
Process Dashboard

Data Extract Process

Completed, 27

Resolved, 8

Failed, 45

Right-click the filter name to update the filter properties such as filter name and
filter label.




* Process Type

Al Q

Filter Properties

] Filter Name: I

Process Type

Resource ID:
PRM_PROCESSTYPE_SL

Filter Label:

Process Type

7. Clickto manually create a filter.
The Filter Manager pop -up box appears.
Click Create New Filter to add a new filter. Click the + icon to add a new

filter/parameter, + to select the Dashlet Affected from the drop -down, and + to
select the affected Filter/Parameter from the drop -down.

Click X to delete a filter.

In general, the parameter in the Filter Group shows the pre-existing
filter/parameter  available in the report/view. Manually created filter is not
required most of the time and is only useful if you need to duplicate the
parameter or apply the same parameter to different dashlet/parameter.

Filter Manager

Source Dashlet Filter/Parameter Dashlet Affected Filter/Parameter Affected
End Date [DashBoardReport v| [PRM_TO_STDATE v * ®
Filter Group Process Type [DashBoardReport v| [PRM_PROCESSTYPE_SL v * x
Start Date [DashBoardreport v| [PRM_FROM_STDATE v * x
Manually Created Filters Test [DashBoardreport v| [status v| + i

Create New Filter

n Cance'

The Filter Manager displays the filter-to-dashlet mapping, and includes
the following columns and buttons:

1 Source Dashlet: The name of the dashlet where the filter originates. It can
also display Filter Group (multiple filters in a single dashlet) or Manually

49




50

1

By default, a dashboard automatically

Created Filter (filter created using the filter manager).
Filter/Parameter: The name of the filter.

Dashlet Affected: With a dropdown menu including all dashlets that
can be affected by that filter.

Filter/Parameter Affected: With a dropdown menu including all
parameters associated with the selected dashletin the Dashlet Affected
column.

Add button: Used to add additional dashlet/parameter combinations to a

filter.

Delete button: Used to delete a dashlet/parameter  combination.

in its input controls. When the dashboard includes the Apply button,
dashboard does notupdate until you click the Apply button.

Click Save Dashboard.
The dashboard issaved tothe Repository.

updates when you change the values



Adding a Custom URL to a Dashboard

You can create a dashlet that displays any URlL-addressable content. It can
help you leverage data from many sources in a single, integrated view.

Toadd a custom URL, complete the following steps:

1. Locate the dashboard. Select the folder, right-click the dashboard in the
Content pane, and select Open in Designer .
The dashboard displays in the Dashboard Designer.

2. Inthe Available Content list, select Web Pagein the New Content folder, and
drag it to the dashboard.

You are prompted to enter the URL of the web page you want the frame
to display.In the Web Page Addess (URL): field, specify a URL.

Dashlet URL

Web Page Address (URL):

http://www.bing.news

n o

3. If the report contains input controls, the control values are listed. You
can select values and parameters to pass tothe URL.

4. Click OK

In the following example, the URLiswww.bing.com/news . The check box next to
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Country was selected for that input control. In the URLParameter Name field, the
default text (Country) was replaced with the letter . Note that this field is case -
sensitive. Thiswill map the d as h b o aCodniys input control to Bi n b s
(query) parameter. Now, when you select a value in the Country input
control, the value passes to www.bing.com/news, so that the news displayed
in the frame relates to the selected country.

The other two input controls in the example also display in the URLdefinition
window. If www.bing.com/news  accepted a parameter that was compatible
with these input controls, you could check their check boxes to associate the
URLwith these input controls as well.
When you select a new value from the Country input control and click Submit, the
news displayed in the custom URLframe changes.

Custom URL

Enter the URL for the frame, including any fixed parameters

www.bing.com/news

Input Control URL Parameter Name
[T Country q

[T Orderld OrderId

[T RequestDate RequestDate

5. You can resize the custom URLframe. You can drag the custom URL
frame to resizeit.

6. Right-click the custom URLframe and select Auto-refresh dashlet contents on the
Dashlet Properties pop-up window.

The menu expands to display options for how frequently to refresh the f r ame d s
content. Smaller values make the frame refresh more often. By default, a dashlet is
never automatically refreshed (that is, its Auto -refresh Interval isset to Manual Only).

Auto -refresh only affects the end-user view of the dashboard. In the
Dashboard Designer, the dashboard isnever auto -refreshed.

7. Click Save.
The dashboard issaved to the Repository.
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The following screenshot is an example of the Hyperlinked dashboard.

lilINFOGI A Ubary  Quicklinks  View- Mansge.  Create,

SampleDashbroard

Date e after

2015-06-01 10:00:00

SiderChan ¢ ChartReport

Kolkata, AL
Q13015 20%

® Fleid A (Average) 1,005.00
® Saliy (Rwerage) 36,36667

. city Date Salary Figld A 7
(Average) (Average)
Kolkata .':I:; 2015 ; . ;
Aug 19, 2015
W Fiesa A (Average) I Aalary (Average) Oct 21, 2015 ‘_
The screenshot has three dashlets in the dashboard that are hyperlinked.
Updating the Date isafter filter updates the three dashlets simultaneously.
A  Ubmry QuickUnks View. Manage- Create- admin | Log Out Q
| SempleDashboard
s
i
o
W cid A (Avernge) I Salary GAverage)
City Date Salary Field_A
{Average) {Average)
Kolkata Aug 18, 2015 2850000 1.01050
R Oct 21,2015 34,100.00 101300
Totals 31,860.00 1,012.00
Totals Totals 31,860.00 1,012.00
W i A Average) I Salary (Average

Designing Dashboards: Tips

When you create or edit a dashboard, keep the following tips in mind:

A Charts and small crosstabs are best suited to dashboards. However, you
can design table reports that work well in the dashboard. Such reports
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tend to be very narrow and are typically used with input controls to limit
the number of rows they return.

Keep reports small because dashboards typically contain more than one. In
particular, reports s h o u | Hen @d wide, as horizontal room is always at
a premium in a dashboard. The server strips margins from an Ad Hoc report
when displaying the report on a dashboard.

>

>

You can design dashboard controls to accommodate  different languages.
First,use the $R syntax to define prompts and static lists of values. Next,
attach resource bundles to the report that contain translations of the prompts
and listsof values. Finally, add the reporttothe dashboard.

)

When designing input controls for a dashboard, keep these guidelines in mind:

0o Topass a value to an external URL,the URLParameter Name you give to
the input control must match the name of a parameter that the URLcan
accept.

0 Thevalue of the input control must also be a value the URLcan accept.

0 The target URL s likely to have additional requirements and limitations.
For example, the name of the parameter may be case -sensitive; in this
case, the value you enter in the URL Parameter Name field is also case -
sensitive.

0 The input control must pass data that the URL can accept. Otherwise,
the server may be unable to retrieve the correctdata from the external URL.

Specifying Parameters in Dashlets

You can add parameters to dashlet names, text dashlets, web page dashlets,
and hyperlinks in chart dashlets. When you add a parameter, you must map a
filter in the dashboard tothe parameter.

Simple Parameters

For text dashlets, web Ilinks, and dashboard names, use the syntax
$P{parameter_name} to directly passthe parameter value tothe web
page. Examples:
A In a text dashlet, enter the parameter in the Text
box: Product Family: $P{Product Family}

A In a web page dashlet or a web link in a chart dashlet hyperlink, enter
the parameter inthe Web Page Address (URL)text box:

http://en.wikipedia.org/wiki/$P  {Customer Country}
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A Dashlet name: Enter the parameter in the Dashlet Name
box: Unit Sales for $P{Product Family}

For Repository hyperlinks in a chart dashlet, use the syntax
?filter_in_target=$P{dashlet_paramj}. For example, the following link sets the
c_country_1 input control in the 05. Unit Sales Trend report to the value of a
Store Country parameter inthe dashlet.

repo:/public/Samples/Reports/05._Unit_Sales_Trend?c_country_1=$P{Store Country}

Note: To find the correct name for a filter in a target resource, open the
Dashboard Designer in a new window, and add the resource to the canvas.
Then expand the resource's folder in the Filters panel and hover over the filter
whose name you want to see.

Parameters in multi-valued input controls

For multi-valued input controls, you can define a separator for the input
control values:

A For text dashlets, web links, and dashboard names, use the syntax
$P{parameter_name ? "separator"}. The following example in a text box
displays results like Product Family: Drink + Food:

Product Family: $P{Product Family ?"+"

>

For Repository links in a chart dashlet, use the syntax ?$P{"filter_in_target=",
dashlet_param, ? "&"}. For example, the following link allows multi-select with
the c_country_1 input control in the 05. Unit Sales Trend report:

repo:/public/Samples/Reports/05._Unit_Sales Trend?$P{"'c_country_1=", Store
Country, "&"}
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When Mexico and USAare selected, this expands tothe following link:

repo:/public/Samples/Reports/05._Unit_Sales_Trend?c_country_1=Mexico&c_cou
ntry_ 1=USA

Note : For the Date input controls to work fine from dashboard to linked reports,
date format along with the parameter should be passed as hyperlink
parameters.




%2 Charts Pro properties B %

Chart properties
The dialog allows to configure all additional and advanced ion of the Charts Pro component. ’

Chart Configuration | Chart Data | Hyperlink

Hyperlink Target ~ Blank v
Hyperlink Type  ReportExecution v

Hyperlink Parameters | Toottip|

Parameter Name Expression
_report "/Infogix/DataViews/DataCheck_DV_Nov10/Entities/DATACHECK_DE_N...
BeginDate DATEFORMAT(SP{BeginDate},"yyyy-MM-dd")

EndDate DATEFORMAT(SP{EndDate},"yyyy-MM-dd")

¥ Modify Parameter |5 e

Link Parameter Name  BeginDate

Value Expression DATEFORMAT(SP{BeginDate},"yyyy-MM-ddl) = ‘j

| OK Cancel

Mapping Parameters in the Filter Manager

After you have created a parameter, create a mapping for it as follows:

NoR D

4.

A

Mapping parameters in dashboard names and text or web screen dashlets:

In the Dashboard Designer, cIi to open the filter manager.

In the filter row where you want to add the new filter, click +. A row
containing new affected dashletand filter/parameter dropdown menus
appears.

Using these new line-items, select the dashlet where you added a parameter,
then selectthe parameter.

Click OK to apply and save or Cancel to discard your changes.

Mapping parameters in chart hyperlinks:

To have JasperReports Server create a parameter mapping automatically:
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1.

Dashlet Properties dialog box for your chart, use one of the names in the
Available parameters listasthe name of your parameter.

Click OK to close the dialog box and create the
mapping. Tocreate a mapping in the filter manager:

In the Dashlet Properties dialog box for your chart, click Create Links in
Filter Manager... to open the filter manager.

In the filter row where you want to add the new filter, click +. A row
containing new affected dashletand filter/parameter dropdown menus
appears.
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3. Using these new line-items, select the dashlet where you added a parameter,
then selectthe parameter.

4. Click OKto apply and save or Cancel to discard your changes.

Editing a Dashboard

You can edit a dashboard if you have the required
permissions. Toedit a dashboard, complete the following
steps:
1. Click View > Repository .

The Repository displays.

2. In the Folders pane, navigate to the folder containing the dashboard you
want to edit. Selectthe folder containing the dashboard.

3. Inthe Content pane, right-click the dashboard and select Open in
Designer . The Dashboard Designer displays with the selected
dashboard.

Edit the dashboard by adding, removing, resizing, or dragging content.

5. Whenyou have edited the dashboard, click Save Dashboard.

To create a new version of the dashboard, select Save Dashboard As
from the Dashboard Selector context menu, and specify a new name.




Sample Dashboard
O « » o Y &% =

DashBc¢ Save Dashboard

Save Dashboard As...

Process Monitoring Dash-Board

Data Extract Process

Report Run Process

HINFOGIX

Custom Visualization:
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Custom visualization component

Perceive Reports.

CustomVisulaization

lets you leverage third -party JavaScript libraries, such
as D3, in Perceive. Itisa powerful and flexible feature suitable for advanced

users of

Cirde_Packing '

v
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When the reportis exported in any other format, PhantomJS, an off-screen application
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to render web pages, isused to execute the script and extract the SVG image, which
may be used as it is (when exporting to PDF), or converted in an high quality image
(for export formats like DOCX or ODF).

Note: PhantomJS is not shipped with Perceive. When using the custom
visualization component, it is necessary to install PhantomJS separately and the
executable should be in system path. It is available for all the major Operating
System from http://phantomijs.org/.

Legacy Dashboard

Dashboards created with the earlier designer tools (Studio 5.5 and prior) are
not compatible with the Studio 6.1.0; they are marked as legacy dashboards. You
can still view them using the legacy dashboard designer. However, the legacy
dashboards cannotbe edited or exported.

The new dashboard environment doesn't currently support some capabilities of
legacy dashboards:

9 The ability to add file-type resources (such as images) to dashlets.

1 The ability to pass parameters using HTTPscreen references.

1 Self-targeted hyperlinks that come from embedded

In the below screenshot, Sample_Dashboard

HINFOG|X

PERCEIVE
| Folders

|§[_, root
EL Infogix
|§1_.Admm
ProcessMonitoring
|§1_. Common

Images

# Lbrary Quick Links View Manage~

Repository

Name

Test Dashboard

Sample_Dashboard

Create »

reports.

isa legacy dashboard.

Description

Type
Dashboard

Legacy Dashboard

admin | Log Out

Created Date
11/20/2015

11/20/2015

Q

Sort By: Name | Modified Date

Modified Date

11/23/2015

11/18/2010



http://phantomjs.org/
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Working with the Ad Hoc Editor

Ad Hoc Editor isthe interactive designer for creating and editing an Ad Hoc View.
The Ad Hoc Editor creates tables, crosstabs, and charts as you drag and drop
elements. You can select report types, add fields, define groups, select labels
and styles, and select summaries and data formats for each field. Ad Hoc reports
are based on Topics or Domains. Both are Repository objects that are defined
by Data Analysts or Administrators to provide a prepared view of a data source.
While Topics contain the fields used directly in a report, Domains give you more
flexibility to filter the data, create input controls, and control the list of available
fields.

Generally, Administrators or Studio users create Topics as JRXML files. They can
also be created from a Domain.

Depending on your configuration, the Reports interface may load a Topic or Do ma i
entire result set into memory when you edit or run the report. If the data policies are
disabled, ensure that each Topic or Domain returns a manageable amount of data,
givenyour e n v i r o nloae napatiy. Alternately, you can change the data loading

policy.

You can edit Ad Hoc View in the Ad Hoc Editor if they were created there originally,
but you cannot edit Ad Hoc View in the editor if they originated in Studio.

For more information on creating reports using Studio, see the Jaspersoft Studio User
Guide.

Thischapter contains the following topics:

>

Understanding the Ad Hoc Editor Workspace

>

Designing an Ad Hoc Report
Additional Features of the Ad Hoc Editor
Working with Charts

>

>

>

Working with Crosstabs: Tips

>

Creating Custom Fields

>

Using Input _Controls and Filters

>

Creating _a Report from a Domain

>

Creating Topics

>

Configuring System-Level Ad Hoc Options




Understanding the Ad Hoc Editor Workspace

When you create a new Ad Hoc View or edit an existing Ad Hoc View, the
Ad Hoc Editor opens. The following sections describe the tool bar icons, the
data source panel, the reportarea, and the filters panel.

The Data Source Panel

The data source panel on the left-hand side of the Ad Hoc View area contains a
list of available fields in the chosen Topic or Domain. If you are using a Domain,
fields may display in named sets. Use the plus and minus icons beside the set
name to expand or collapse a set of fields.

Available fields may be divided into two sections in the panel, Fields and Measures .

To hide this panel, click the icon in the top left-hand corner next to the Topic or
Domain name. Thisis useful when arranging content in a large report. Click the
same icon on the minimized panel to expand it.

Domain: DataCheck...

Fields

! Control Data

ETE| createTime

[T updateTime

[Tl| controlPoint

| empname

[T gendar

T hiringdate

| partitionKey

ET| IvP_CREATEDDATE

Measures

3l Control Data

The Report Area
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The tool bar at the top of the report area provides access to many functions of
the Ad Hoc Editor. Refer to The Ad Hoc Editor Toolbar for descriptions of the tool
bar icons.




Directly beneath the tool bar isthe Layout Band, which has two fields. These
fields have different labels and functions, depending on the type of report you
create:

Type Fields

Table Columnsand Groups
Chart Measuresand Groups
Crosstab Columnsand Rows

You can drag and drop fields and measures into these boxes to populate your
report.

The Filters Panel
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The filters panel on the right-hand side of the report area displays any filters
defined for the report. You can set the filter values and see the resulting change
in the report

area. To hide the filters panel, click the icon in the top left-hand corner of
the panel. Click the same icon on the minimized panel to expand it again.

Filters

* A.empname equals =

BOB59%974

BOB5SS74
BOB59975
BOB59%976
BOB59S77
BOB59978
BOB59979
BOB59S80
BOB59981
BOB59982
BOB5SSB3
BOB59954
BOB59985

» Custom Filter Expression




Designing an Ad Hoc Report

When you design a report in the Ad Hoc Editor, you create a Hoc View and then
create the report from Ad Hoc View.

Selecting the Type of Report

You determine the type of reportwhen you define the report, but can change the
type at any time when the Ad Hoc View isopen in the Ad Hoc Editor. Available
options are table, chart, and crosstab.
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Table

A

Use tables to view all the data in the report or to summarize the data across
one set of related fields.

A Columns can include both properties and measures; each row represents an
object being measured. Rows can be grouped by their properties.
A Example: In a report on orders, each column might contain one
measurement of the orders, and the rows could be grouped by sales region,
city, and product.
Q. Sample
updateTime controlPoint empname gendar hiringdate
MNov 6, 2015 EMPLRDATA_CP BOB59981 M Jan 13, 2001
MNov 6, 2015 EMPLRDATA_CP BOB59950 M Feb 8, 2010
Nov 6, 2015 EMPLRDATA_CP BOB59957 M Jan 3, 2001
MNov 6, 2015 EMPLRDATA_CP BOB59975 M Jan 7, 2001
Nov 6, 2015 EMPLRDATA_CP BOB59980 M Jan 12, 2001
Nov 6, 2015 EMPLRDATA_CP BOB59984 M Feb 2, 2010
Nov 6, 2015 EMPLRDATA_CP BOB59986 M Feb 4, 2010
MNov 6, 2015 EMPLRDATA_CP BOB59987 M Feb 5, 2010
Nov 6, 2015 EMPLRDATA_CP BOB55958 M Jan 4, 2001
MNov 6, 2015 EMPLRDATA_CP BOB59983 M Jan 15, 2001
Nov 6, 2015 EMPLRDATA_CP BOB5598%9 M Feb 7, 2010
Nov 6, 2015 EMPLRDATA_CP BOB59991 M Feb 9, 2010
MNov 6, 2015 EMPLRDATA_CP BOB59974 M Jan 6, 2001
MNov 6, 2015 EMPLRDATA_CP BOB59955 M Jan 1, 2001
MNov 6, 2015 EMPLRDATA_CP BOB59956 M Jan 2, 2001
Chart

A Usecharts to compare one or more measures across multiple sets of related




fields.

A Charts summarize data in a graphical representation that can highlight your
success and failures. With the exception of time series and scatter charts,
each type of chart compares values for a set of groups.

A Example: You could click the Chart tab to view the data in a bar chart that
showed the orders filled, orders placed, and paymentreceived foreach of the
products.

9. Sample

Depending on your needs, you could configure the chart in a number of
ways. You could group the bars by region or city, or use a completely
different chart type, such as a pie chart in which each slice depicts the
payment received grouped by sales manager.

Crosstab

A Use crosstabs to summarize data across multiple sets of related fields.

A Crosstabs are more compact representations than tables. Columns and
rows specify properties; cells contain the summarized measurements.




A Example: The previous example could be displayed in a crosstab with
columns grouped by sales managers and representatives, rows grouped
by region, city and product, and three data measurements in each cell.

Sample
Measures
updateTime | 2§
controlPoint | 26
empname 26
gendar 26
hinngdate 26

Selecting the Content of a Report

Inthe Ad Hoc Editor, you can select contentto design a report.
To design a table inthe Ad Hoc Editor, complete the following steps:

1. Log into the Reports interface.

2. Click New > Ad Hoc Report.

The content appears as View as tree and View as list. In this example, click View
as tree where the Repository structure is followed. View as list displays all the

content as a list.

3. Selectthe required topic and click OK.
Select Data

| root

() =) ]

| Public
|§| | Ad Hoc Components
E-| | Topics
| Audit

| Monitoring
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4. In the Data Chooser screen, select the required fields and click > to move
them from the Source to the Selected Fields section.

5. Click OK

The Adhoc Designer in Table/Crosstab view has been enhanced to display the
total row count.

The following property has been modified in the IV.properties
file to display the row countin Adhoc Designer.

JS_ADHOC_ROW_COUNT= true

Thisproperty isset to false by default.
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EII INFOGIX # tbrary View, Manage, New, admin | Log Out _m
PIRCEIVE
) Domain: ShowandTell_... 5. || EmpDetails_TableView o Filters
Fields O H.B., « » o [J7%t E [ 55 [Table [+] [Sample Data[v rotal Records 171| £ A-empname isone of v @«
&7 Control Data -
= Columns  empname *  gendar x  hiringdate x | salary x
[} createTime %
[} updateTime Groups o
[ controlPoint v
[ empname o, Click to add a title 7
0| gendar T == == = =] v
- empname gendar hiringdate salary |
|| hiringdate t | v
2 2
B pariitionkey | soB12 M Jan 12, 2001 12.76 >,
|
[ 1vP_CREATEDDATE BOB16 M Feb 2, 2010 52.80 v
BOB23 M Feb 9, 2010 63.99 7
| v
BOB4 M Jan 4, 2001 32.86
v
BOBL M Jan 1, 2001 93.56
| soB10 M Jan 10, 2001 27.33
| BoB3 M Jan 3, 2001 74.53
BOB25 M Feb 11, 2010 55.46
Measnres =|| | sos7 M Jan 7, 2001 10.84
St control Data - ; BOB19 M Feb 5, 2010 88.37
i BOB2 M Jan 2, 2001 76.03
-
 cvele 1=l | soB13 M Jan 13, 2001 8.80
= run |
= BOB14 M Jan 14, 2001 51.42
{ processHistid |
= historyType BOB17 M Feb 3, 2010 68.78 [+ Custom Filter Expression
= retentionClass BOB18 M Feb 4, 2010 61.75
. I Apply
= empid i

The fundamental

A Tool bar

>

Domain or Topic

A

A

Report area

Each of these areas is explained

Editor Workspace .

areas in the Ad Hoc Editor are:

in greater detail in Understanding

Data Source panel, which displays the listof available fields from the selected

Filters, which define a subset of data to retrieve from the data source

the Ad Hoc

from the data source panel onto the report area to begin.

the table,

When you create a new report, the report area isempty. Drag and drop data fields

right-click the column and select Remove

from Table, or delete the c o | u mlabélsin the Columns field at the top of the report

6.

7. To remove a column from
area.

8.

Toadd a group, right-click on a field in the listof fields and select Add as Group from

the context menu. The report area refreshes and displays your selected data grouped
by the selected field, and the column name of the selected data displays in the
Groups field atthe top of the report area.

The order of the groups isdetermined by the order in which you added groups to the

report.

9. Tochange the order of the groups, drag and drop a group heading
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label in front of




or behind another group heading label in the Groups field. The report area refreshes
and displays the rows regrouped.

10. If you want to group by a field that iscurrently in the report area, in the list of fields,
right-click the field and select Add as Group from the context menu.

The report area refreshes and displays the data regrouped.

11.To add a summary to a column, right-click the column heading and select Add
Summary from the context menu. In the example, a summary was added to the Value
column.

12. At the top of the report area, click Chart to view this same data as a chart. Right- click
the chartand select Change Chart Type > Pie from the context menu to view a pie chart
of the data. Above the report area, click Table to return to the table view.

H.

13. Place your cursor over to save the Ad Hoc View.
14. Click View > Repository to exit the Ad Hoc Editor.

Saving the Ad Hoc View
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Ad Hoc Editor isthe interactive designer for creating and editing an Ad Hoc View. You can
explore and analyze data from your Topic or Domain data source. Ad Hoc Views can also
be used to create contentfor reports.

You can save an Ad Hoc View as a chart, table, or crosstab.

To save the Ad Hoc View, click the Save icon on the toolbar, and choose one of the
following options.

Save Ad Hoc View
A Save Ad Hoc View As

>

A Save Ad Hoc View and Create Report

@ If you are saving a chart and the Save button isdisabled, there isa problem
with your data that is preventing the generation of chart.

Correct any issuesyou have with groupings, aggregations, etc. until you
are able to save the chart.

Save Ad Hoc View
The Save As pop -up window displays.
1. Specify an Ad Hoc View name, which ismandatory.

2. Specify an Ad Hoc View description, which isoptional.
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Navigate through the tree structure to your folder in the Repository to save the Ad Hoc
View.

Click Save.

Save As

Data View Name (required):

Sample Ad Hoc View

Data view Description:

| Infogix
| Organizations

| Public

H) N [

Save Ad Hoc View As

The Save Ad Hoc View As option allows you to save the report in a different name. The steps
for savingthe report usingthe Save Ad Hoc View and Save Ad Hoc View As options are the same.

Save Ad Hoc View and Create Report

The Save Ad Hoc View and Create Report pop -up window is displayed.

1.
2.
3.

Specify an Ad Hoc View name, which ismandatory.
Specify an Ad Hoc View description, which isoptional.

Navigate through the tree structure to your folder in the Repository to save the Ad Hoc
View.

Specify a report name, which ismandatory.
Specify a report description, which isoptional.

Navigate through the tree structure to your folder in the Repository to save the
report.

Select the Default Report Template radio button.
Click Save.




Save Ad Hoc View and Create Report

Data View Name (required): Report Name (reguired):
Sample Ad Hoc View Sample Ad Hoc View Report
Data view Description: Report Description:

| Infogix | Infogix

)]
)]

| Organizations

3]

| Organizations

()

| Public

3]}

l Public

E3]]

Generate Report with:

'3§3' Default Report Template

O custom Report Template

m ca nce'

9. Inthe Report Name field, specify the report name.

10. In the Description field, specify a brief description to help you identify the report later.

11. Navigate through the tree structure to the folder where you want to save the
report.

12. Click Save.

The Ad Hoc Editor displays the totals (sum) for each name, city, and country, and displays a
context menu where you can change or remove the summary function if necessary.

Editing Ad Hoc View

Toeditan Ad Hoc View from the Repository, complete the following steps:
1. Log into the Reports interface.

2. Click View > Repository .
The Repository screen displays.

3. Right-click the Ad Hoc View and select Open .
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(Al AVIDEMO
(B4l Common
Al DataSources
{5l DataViews
fAal DataCheck_DV_Nov10
{5al DE_DV_Datefield
{fial DEPARTMENT
DV SPC ASSURE
Sl dv1
(Al DataDomains
(Sal Entities
Sl de1
DataDomains

(B4l Domain_Reports
fBal Organizations
Public
(Bal Temp
Themes

ININFOGI X A Lbrary QuickLlinks View
PERCEIVE
) Folders Repository
5l root Run Edit = Open
B s O ame
#ad Admin

Manage +

Create v

Copy Delete

Ad_Hoc_View_Report.pdf

Ad Hoc View Report

o ]

Create Report

Copy

Cut

Delete
Permissions...
Properties...

Export

Description

Type
Content Resource
Report

Ad Hoc View

admin | Log Out

Created Date
11/13/2015
11/13/2015

11/13/2015

Sort By: Name | Modified Date

Modified Date
11/13/2015
11/13/2015

11/13/2015

Copyright © Infogix, Inc.

The report appears
export the reportin

Click one of the options

following formats: PDF, Excel (Paginated),
XLSXtext only, or PPTX.

(Paginated),

HINFOGIX A ubary Quiklinks Views
PERCEIVE
: dvl del Inf... E- Ad Hoc View
- o8« o
{57 Control Data Shiomns: As PDF
(4 5
I} createTime As Excel (Paginated)
[ Ti Groups
|[F) updateTime As Excel
[l controlPoint
o,. As CSV
] partitionkey
= ____ AsDOCX
|l PS_cost_center PS_first_ni
==S=" AsRTF
[il] PS_sequence_number 5
ames
] Ps_account As ODT
Robert:
[fT| ps_bank_routing operts As ODS
[ ps_reference Janies As XLSX (Paginated)
[ Ps_date Dazzelle As XLSX
[ Ps_last_name Miller As text only
] Ps_first_name Reese As PPTX
| PS_address Kim Aug 23, 2013
[T Ps.
0 ps_city Grau Feb 22, 2013
[l Ps_state
Campbell Jul 26, 2013
| PS_zip_code
Il 1VP_CREATEDDATE Rodriguez Jul 20, 2013
Hill Dec 12, 2013
Saliers Mar 26, 2013
Vasquez Oct 5, 2013
Owens Nov 28, 2013
Sweet Jan 3, 2013
Measures B =
Control Data
“f spacer

Manage+ Create

2t E

PS_state x

PS_state

PA
OH
AK

MN
MS
PR

MT
MD
MD
NY

DC

MD

Sample Data VvV

admin | Log Out

Copyright © Infogix, Inc)|

in Ad Hoc View. You can now edit the Ad Hoc View and
the required format.

in the top right corner to export the report to any of the
Excel, CSV, DOCX, RTF,0ODT, ODS, XLSX

Eiltor
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The following

table describes the export options.

(Paginated)

Format Spreadsheet

Option Format Name Usage Suggestions

PDF Adobe Acrobat To prevent horizontal truncation of an Ad Hoqg
report when exported, set the Actual Size
option in the Ad Hoc Editor.

Excel XLS Not recommended for exporting most tables or,

(Paginated) crosstabs. Repeats headers and footers on each
screen.

Excel XLS Ignores screen size and produces spreadsheet-
like output.

Ccsv Comma Separated| Characters outside the Latin 1 character set

Values can cause the Excel spreadsheet to look
unacceptable. Try to save the file and import it
using Excel'simport functionality.

DOCX Word Do not export reports having more than 63
columns. In Microsoft Word, you cannot create
tables having more than 63 columns.

RTF Rich Text Format Creates a large output file and, therefore,
takes longer to export than PDF,for example.

oDT OpenDocument Text | For best results, minimize the number of rowsg
and columns and make sure they do not
overlap.

ODS Open Document SameasODT.

Spreadsheet
XLSX Microsoft Open XML Not recommended for exporting most tables or|

crosstabs. Repeats headers and footers on each
screen.

XLSX Microsoft Open XMl Ignores screen size and produces spreadsheet-
Format Spreadsheet | like output.

Textonly Plain Text Format Unformatted text format that is recognized by
all word processors and text editors. Mos
common file name extension used for plain text
files, and most basic file format used to
transfer data, as it is supported by almost all
applications on most platforms.

PPTX Powerpoint Export the report output to a powerpoint.

4. Toreturn to the Repository, click Back .




Creating a Report from Ad Hoc View

You can create a report from an Ad Hoc View.
Tocreate a reportfrom Ad Hoc View, complete the following steps:

1.
2.

Click View > Repository .
In the Explorer pane, navigate tothe folder that contains your Ad Hoc
View. The Ad Hoc View in the folder display in the Repository pane.

Locate the Ad Hoc View inthe Repository pane.

Right-click the Ad Hoc View and select Create Report.

¢ Folders Repository Sort By: Name | Modified Date

Open Copy Cut Delete

Sample Ad Hoc Ad Hoc View 11/16/2035 111672015

Ad_Moc_View_R
Ad Mo< View Rep'

Ad Hoc View

5. The Create Report pop-up window appears. Select the Default Report Template

radio button.
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Create Report

Generate Report with:

® Default Report Template

(O Custom Report Template

o
A

6. The report appears. Savethe report using Save or the Save As option. Click Save.




i NFO ﬁa!s%‘z & Library Quick Li View~» Managev Createv admin | Log Out Q
Sample Ad Hoc View Report Data refreshed Nov 16, 2015 at 1:24:59 AM  §2
Back A. B. - 4 100% ~ search report Ql~ 4 » Page |1 of 641 P Pp
Save
PS_name PS_date PS_state
James May 13, 2013 PA
Roberts Jul 25,2013 OH
James Jun 25,2013 AK
Dazzelle Nov 17, 2013 1A
Miller Apr1,2013 MN
Reese Dec 26, 2013 MS
Kim Aug 23, 2013 PR
Grau Feb 22,2013 D
Campbell Jul 26, 2013 MT
Rodriguez Jul 20, 2013 MD
McDonald Sep 8,2013 oc
Barker Oct 8, 2013 IN
Copyright © Infogix, Inc)|

7. The Save As pop -up window appears. Specify a report name, which ismandatory.
8. Specify a report description, which isoptional.

9. Navigate through the tree structure to your folder in the Repository to save

the report.
10. Click Save.

NFOGIX

PERCEIVE
Sample Ad Hoc View Report  Dats refrashed Nov 16, 2015 at 1:24:59 AM  §2

ary  Quick Links Viewv Managev Create~ admin | Log Out

Back AH. B. 8 - 4 100% ¥ search report Qv 4 p Page |1 of 641 P Pp
PS_last_name PS_date PS_state
James May 13, 2013 PA
Roberts Jul 25,2013 OH
Save As

Name (required):

Sample Ad Hoc View Report

Description:

{5l root A
(Sl Infogix
(Bl Admin
{3l AVIDEMO
@l common
{5l DataSources
{5l DataViews
(5l DataCheck_DV_Nov10
(5l DE_DV_Datefield
(el DEPARTMENT
il DV SPC ASSURE
Sl dv1
(54l DataDomains
{5l Entities
Sl de1
{5l DataDomains
il DV_Assure v
5. NV_C1 ATMPAYMENT

Copyright © Infogix, Inc.
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11. The report is saved in the specified location. Click Close.

Report Saved | close

Sample Ad Hoc View Report  Data refreshed Nov 16, 2015 at 1:24:53 AM  $2

Back H. B.

PS_name
James
Roberts
James
Dazzelle
Miller
Reese
Kim

Grau
Campbell
Rodriguez
McDonald

Barker

PS_date
May 13, 2013
Jul 25,2013
Jun 25, 2013
Nov 17,2013
Apr1,2013
Dec 26, 2013
Aug 23, 2013
Feb 22, 2013
Jul 26, 2013
Jul 20, 2013
Sep 8, 2013

Oct 8, 2013

- 4 100% |v

PS_state
PA

OH

AK

1A

MN

MS

PR

MT
MD

DC

searchrepot Q|+ | 4 P

Page |1 of 6a1 P P

Copyright ® Infogix, Inc

12. In the Explorer pane, navigate to the folder that contains your report. The

report in the folder display in the Repository pane.

HHINFO S > & Ubrary Quicklnks View- Manage -

Repository
Name
Sample Ad Hoe View

Ad Hoc View Report

Ad Hoc View

Crepte ~

Sample Ad Hoc View Report

Ad_Hoc_View_Repart.pdf

Deseription

admin | Log Out

Q

Sort By: Name | Modified Date

Modifird Date

You can also click the Save Ad Hoc View and Create option to
automatically create a report as described in the section Save

Ad Hoc View and Create Report.
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Working with Reports

While the Ad Hoc Editor allows end-users to create reports from pre -defined
Topics and Domains, you can create reports outside of the Reports interface and
add them to the Repository. You can add these reports in two ways:

A From within the Reports interface, upload a JRXML file to the Repository,
along with any other resources the report needs. When you upload the report,
a wizard guides you through each step.

>

From Jasper Studio, define the report and use the Jasper Studio Reports
interface  plug -in to upload it. Both a simple and a complex example of
uploading a report using the Reports interface wizard are provided, as well as
a discussion of using the Jasper Studio plug -in for the Reports Interface.

Note : Perceive 9.0 will work with Studio 6.1.0 or later versions only. All the
reports created using earlier versions open in Studio 6.1.0.

Thischapter contains the following topics:

>

Overview of a Report Unit
Adding Reports Using a JRXMLFile

>

>

Adding Cascading Input Controls to a Report
Editing JRXMLReport Units

>

>

Localizing Reports

>

Using Studio with the Reports Interface

Overview of a Report Unit

In the Reports Interface, a report unit is a collection of the elements required
to retrieve data and format output. With the exception of the main JRXML file,
these elements can either be local to the report unit, or they can reside
elsewhere in the Repository. In this case, the report unit uses the repo: syntax to
refer to the elements.




References. .. .. =
Data Flow REPOI‘t * Images, fonts, resource
Output bundles, and scriptlets

Adding Reports Using a JRXML File

You can add simple and complex reports using a JRXMLfile.

Adding a Simple Report

To add a simple report unit to the Reports interface, complete the steps in
the following sections.

Identifying the Report and JRXML File

To specify basic identity data and a JRXMLfile for a report, complete the
following steps:

1. Log in to Perceive as an Administrator.
2. Open the Reports interface, click View >

Repository . The Repository displays.

e




3. Navigate to the Reports folder, right-click and select the Add Resource >
Perceive Report in the context menu. The Set Up the Report screen displays.

4. Specify the name, resource ID, and (optional) description of the report.

Select the Upload a Local File or Select a JRXML from the Repository radio
button, and browse to the JRXMLfile you want to use.

Ill INFO pm:‘:zﬁ #&  Library Quick Links View» Manage~ Create~ admin | Log Out Q

Add Report:

Set Up the Report

Set the required values for the report, then, optionally, proceed to other pages in the flow.

Set Up
Name:

Controls & Resources Mew Simple Report

Data Source
Resource ID (required):

= MNew_simple_Report

Customization

Description:
This is a simple example

Locate the JRXML File
O Upload a Local File

@ Select a IRXML from the Repository

/Infogix/DataViews/ER_Nov16/Entities/DE_CLAIMPAYMENT/Reports/TtemOverViewReport_files/reportineml

Browse...

Copyright © Infogix, Inc,

6. Click Controls & Resources.

The Reports interface uploads the main JRXML file. The Controls & Resources
screen may display a message to locate suggested resources.

The suggested resources are missing resources that the Reports interface
needs to validate and run the report.
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# Library  Quick Links View~ Manage~ Create » admin | Log Out

Add Report: New Simple Report

Controls & Resources

Locate the controls and resources used by your report.

Controls & Resources [EEllEs

Data Source Add Resource...

Input Controls

Customization

Add Input Control...
Input Control Options
Display Mode:

Pop-up window v| [7] Always prompt

Optional 1SP Location:

thin /WEB-INF/jsp)

m Cancel

Copyright @ Infogix, Inc.

7. Upload the suggested file resources, if available.

Specifying Controls and Resources

After naming the report and specifying the JRXMLfile, add resources by
completing the following steps:

1. Click Add Resource under the Resources
heading. The Locate File Resource screen
displays.

2. Select Select a resource from the Repository radio button, and browse to an
image file you want to use.

3. Click Select.




Select Resource From Repository

(Bl root

Gl Infogix
[i'_.] Common
{34l Images
DataViews
Organizations
Public
Themes

Select Cancel

The path to the image displays in the wizard.

4. Click Next.
The Add a Report Resource screen displays.
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HMINFOG I X

#  Llibrary Quick Links View- Manage- Create~

PERCEIVE
Add Report: New Simple Report

Add a Report Resource

Set the properties for the resource.

Type: Image

Selected Resource:

/Infegix/Common/Images/report_logo

Mame (required):

admin | Log Out Q

Logo_link

Resource 1D (required):

Logo_link

Description:

LogoLink]

Previous MNext Cancel

Copyright © Infogix. Inc.

5/ The properties include the image name, resource ID, and description.
These properties do not redefine the properties of the image file in the Repository.

Click Next after naming the file resource.

The Controls & Resources screen displays again, showing that the selected

resource was added under the Resources heading.
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HIINFOG | X A Library Quick Links View- Manage. Create~ admin | Log Out

PERCEIVE
Add Report: New Simple Report

Controls & Resources

Locate the controls and resources used by your report.

_ fesaurees

Conirols & Resources

Input Controls

Add Input Control...

Input Control Options
Display Mode:

Pop-up window | [] Always prompt

Optional ISP Location:

VEB-INF/jsp)

Copyright © Infogix, Inc.

Click Data Source.
The Linka Data Source to the Report screen has the following three options:

A Do not link a data source fi Select or define the data source at a later
time. You will see an error if you run the report in this state.

A Click here to create a new data sourcefi Define a new data source that is
only available to your report.

A Select data source from Repository fi Select an existing data source from

the Repository.

If you have an existing data source in the Repository, select the Select data
source from Repository radio button and browse to the appropriate Data
Sources folder. Click Select.

The path to the data source displays.

ERCEIVE

Add Report: New Simple Report

Controls & Resources

lil INFO 9 | % # Lbrary Quick Links View- Manage~ Create~ admin | Log Out Q
Link a Data Source to the Report
Optionally, link a data source to the report. You can choose a data source from the repository or create a new one.
(O Do not link a data source
@ Select data source from repository
/Infogix/DataSources/InfogixD3
Browse...

Customization

Copyright © Infogix, Inc.

Click Query.

The Locate Query screen has the following three options:
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p>)

Do not link a Query i Usesthe query, if there isone, defined within
the main JRXML.If the main JRXMLdoes not have a query, you
cannot run the report.

A Click here to create a new Queryfi Guides you through defining a new
guery, only available to your report.

A Select a Query from the RepositoryfiSelects an existing query from
the Repository.

9. Onthe Locate Query screen, select the Click here to create a new Query
radio button.

Iil INFOGI| X # Lbrary QuickLinks View~ Manage~ Create~ admin | Log Out

PERCEIVE
Add Report: New Simple Report

Locate Query

O Do not link a Query
® Click here to create a new Query

Controls & Resources. Select a Query from the Repository

Data Source

Customization

Cancel

Copyright © Infogix,

Inc.

10. The Name the Query screen displays where you can enter the name,
resource ID, and description of the query. Thisquery and its properties are
visible only within the report unit.

Suppose you are creating a query to retrieve only Canadian accounts.
Enter the following details:

A Namefi CanadaAccounts
A Resource IDfi CanadaAccounts
A Description fi Query for New Simple Report in User Guide




>

EIVE

# Library Quick Links View~ Manage~ Create~ admin | Log Out

IINFOG I

Add Query:

Name the Query

Enter the required property values.

N ired):
e Name the Query ame (required)

CanadaAccounts
Link a Data Source

Define the Query Resource ID (required):

Canadafccounts

Description:

Query for New Simple Report in User Guide

Next Cancel

Copyright @ Infogix, Inc.

11. Click Next.

The Link a Data Source to the Query screen displays. You can select a
query from the Repository, define a new one, or select not to link a data
source.

12. For this example, select Do not link a data source to use the data source

you selected previously.
13. Click Next.

HIINFOG I X

#A Ubrary QuickLinks View» Managev Createw admin | Log Out

PERCEIVE
Add Query: CanadaAccounts
Link a Data Source to the Query

Optionally, link a data source to the query. You can choose a data source from the repository or create a new one.

Do not link a data source

Name the Query
e Link a Data Source

®
@)

Define the Query Select data source from repository

Previous Next Cancel

Copyright © Infogix, Inc.

14. The Define the Query screen displays. Select SQL in the Query
Language drop - down and enter the following Query String to retrieve
only Canadian accounts:

SELECT* FROM accounts WHEREDbilling_address_country
BY billing_address_city

15. Click Save to save the query.
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MMINFOGI X # Lbrary Quick Links View- Manage. Create~ admin | Log Out
PERCEIVE

Add Query: CanadaAccounts

Define the Query

Select a language and enter the query

Nemethe Query  Query Language:

Link a Data Source
Query Stning:
SELECT * from accounts WHERE billing_address_country='Canada’ ORDER BY billing_address_city

» Define the Query

Previous m Cancel

Copyright ® Infogix, Inc.

16. The Customization screen displays. For this example, no customization is

required. Click Submit to submit the new report unit to the Repository.

lil INFOGI| X # Library Quick Links View- Manage~ Create+ admin | Log Out

PERCEIVE
Add Report: New Simple Report

Customization

Locate a custom report view.

J5P Location:

Controls & Resources

Data Source

Que

Customization

Cancel

Copyright @ Infogix, Inc.

Completing the Report

To submit a new report unit to the Repository, click Submit on any screen
of the Report wizard. You do not have to set options on screens, such as
Customization, which is not required. When you click Submit, the Reports
interface validates the report unit.

After clicking Submit, a message displays at the top of the Repository screen,
indicating that the report was successfully saved. The report displays in the
Repository with the description you entered on the Set Up screen. To run the
report and view the output, click its name.




Adding a Complex Report
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You can create a more complex report with a full set of input controls, as
well as a scriptlet class JAR file and resource bundles. To create the report,
you must have access to all itsresources, a datatype, and an image for the
logo.

Identifying the Report and JRXML File

To specify basic identity data and a JRXML file for a report, complete the

following steps:

1. Log into Perceive as a Reports interface Administrator and select View >
Repository.

2. Navigate to a folder to add the report. Forexample, navigate to Organizations
>

Organization > Organizations > Folder Template >
Topics.

3. Right-click the Topics folder and select Add Resource > Perceive Report
from the context menu.

4. The Set Up the Report screen displays. On the Set Up the Report
screen, enter the details in the Name , Resource ID, and Description
fields.

5. Select the Upload a Local File or Select a JRXML from the
Repository radio button. For this example, use Select a JRXMLfrom
the Repository .




6. Click Browse to locate the JRXML file.

#  Library QuickLinks Views Manage- Create~ admin | Log Out

Set Up the Report

Set the required values for the report, then, optionally, proceed to other pages in the flow.

“ Name:

Controls & Resources New Complex Report
|
Resource 1D (required):

Description:

Locate the JRXML File
(O Upload a Lacal File

Browse...

@ Select a IRXML from the Repository

/nfogix/DataViews/DV_CLIAMPAYMENT3/Entities/DE_CLAIMPAYMENT/Reports/MatchedItems_files/repertIrxml

Browse...

Copyright © Infogix, Inc.

7. After you open the JRXMLfile, click Controls & Resources.

On the Controls & Resources screen, the list of suggested
resources displays, if available.

fIINFO ﬁnlltﬁ #& Library Quick Links View- Manage- Create~ admin | Log Out

Add Report: New Complex Report

Controls & Resources

Locate the controls and resources used by your report.

Controls & Resources SIS

Add Resource...

Data Source

Input Controls

Customization
Add Input Control...

Input Control Options

Display Mode:

Pop-up window v | [7] Always prompt

Optional 15P Location:

Conurighr @ Infoake Tnc

8. On the Controls & Resources screen, upload any suggested
resources by completing the following steps:

a. Click Add Resource inthe same row as the suggested
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resource. The Locate File Resource screen displays.
b. Select the Upload a Local File radio button.
c. Click Browse and locate the JRXMLfile.
The path to the JRXMLfile displaysin the Upload a Local file field.

d. On the Locate File Resource screen, click Next.

e. On the Add a Report Resource screen, click Next to accept the
default report resource name and resource ID.

Adding Input Controls
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Input controls are graphical widgets the Reports interface displays with
the report. Input controls perform the following functions:

A Prompt the user for input
A Validate the format of the input
A

Passthe input to the report

Based on the input, the Reports interface modifies the WHEREfilter
clauses in SQL parametrized queries.

Input controls correspond to the parameters defined in JRXML reports, such
as

$P{name}. The Reports interface maps the value that the user enters for
the input control to the parameter of the same name. If you define an
input control in the Report and the Reports interface cannot find a
parameter by the same name in the JRXML,the input control does not
function when the report runs.

@ The JRXMLcan define a default value for the input control. To prevent users from
changing the default, you can make the input control read-only or invisible.

When you create an input control, define or use a predefined datatype for
user entries. Datatypes define the expected input (numbers, text, date,
date/time, or time) and can include range restrictions that the Reports
interface  enforces. The Reports interface uses the datatype to classify and
validate the data.

To define a datatype, set properties on the Set the Datatype Kind and
Properties screen.
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Iil INFO pcm!‘“xi & Llibrary Quick Links View~ Manage- Create~ admin | Log Out Q

Add Datatype
Set the Datatype Kind and Properties
First, select the kind of datatype you wish to add, then enter the required property values.
Type:
Number
Date
Date/Time
Name (1 Time
Resource ID (required):
Description:
Pattern:

Copyright € Infogix, Inc.

The previous example shows the properties that define a Date datatype.
Properties differ for other datatypes that display on the Set the Datatype Kind
and Properties screen. The table below describes the properties that can be used.

Properties Description

Type The classification of the data, which can be Text, Number, Date, or
Date-Time.

Name The name of the datatype.

ResourcelD The unique ID of the datatype that you cannot edit.

Description Any additional information you want to provide about the datatype.

Pattern A regular expression that restricts the possible values of the field.
Displayswhen the Text type.

Minimum value The lowest permitted value for the field.

Maximumvalue The highest permitted value for the field.

Minimum Is Strict If selected, the maximum value itself is not permitted. Pemmits only

valueslessthan the maximum value.

Maximum s Strict If selected, the minimum value itself is not permitted. Permits only
values greater than the minimum value.

Choose one of the following widget types for the input control:

A Boolean fi A check box widget for entering a yes/no value.

A Single value i A text, number, date, or date/time widget. Input can be




constrained to a minimum value, maximum value, or both. Textinput can also
be constrained by a matching pattern. A text box widget for entering a
value, or a calendar for entering date and date/time.

b

Multiple values i One of the following widgets that present a static list of
values, or a dynamic listof values returned by a separate query, to the user.

o Drop-down listto select a single value
o0 Radio buttons to select a single value
0 Multi-select listto select multiple values
0 Check boxes to select multiple values
After determining the listof values to be presented to the user, choose the widget.

The query in the JRXML file referenced in the previous example,
SalesByMonth.jrxml, has several input control parameters, one for each different
type of input control. The following procedures show you how to add each type
to the report unit.

Adding a Text Input Control

The simplest input control is a text box. In this example, the datatype for the
input value is a number; the Reports interface verifies that the user enters a
number into the text box.

To add a text input control to the complex report example, complete the
following steps:

1. Click Controls & Resources in the Report wizard.
2. Onthe Controls & Resourcesscreen, click Add Input Control .

3. The Locate Input Control screen displays. Select Define an Input Control in the
next step.

4. Click Next.

On the Create Input Control screen, accept the default type of input from
the

Type drop -down: Single Value.

6. Complete the following fields for the input control:

The name isreferenced in the main JRXMLfile, so be aware when entering it.

90

A Prompt Textfi The label thatthe user sees nextto the widget for this input




A Parameter Name fi The name of the parameter in the report that
receives the user value, such as Textinput
A Description i An optional description that displays only within the
report wizard
A Mandatory, Read-only, Visible fi A setting that affects how the input
control is displayed
Iil IN Fogm'lnﬁ # Library Quick Links View~ Manage- Create~ admin | Log Out Q
Add Input Control
Create Input Control
First, select the kind of input control you wish te add, then enter the required property values..
Type: [Single Value v
Prompt Text (required):
Text Input Contral
Parameter Name (required):
Text_Input_Control
Descniphion:
[ Mandatory
[] read-only
Visible
Next Cancel
Copyright © Infogix, Inc.
To reuse an input control, add it to the Repository independent of any
report using Add Resource > Input Control . Before using the input control in
a report, check that the parameter name in the JRXMLmatches the name
in the Create Input Control screen. The Reports interface cannot run the
report otherwise.
Click Next.

In Locate Datatypes, select Define a DataType in the next step, and click Next.

Instead of defining a datatype, you can use one in the Repository if its type

and range are compatible with your input control.

In Set the Datatype Kind and Properties, complete the following fields
for the datatype:

A

In Type, select the format of the data that the user may enter,
such as Number.

A Enter a name in the Name field.




The number format allows usersto enter integers and decimals.

A Enter aresource IDin the Resource ID field.

The name and resource ID are required, but are only visible when
defining the input control.

# Library Quick Links Views Manage- Create~ admin | Log Out
Add Datatype
Set the Datatype Kind and Properties
First, select the kind of datatype you wish to add, then enter the required property values.
Type:
Name (required):
Integer Type
Resource ID (required):
Integer_Type
Descrigtion:
Pattern:
Copyright ® Infogix, Inc.

A The following fields are optional:

Description fi Displaysonly within the report wizard

Minimum value fi The lower bound of the value the user may enter
Maximum value i The upper bound of the value the user may enter

O O O o

Minimum is strict i Indicates the minimum value itself is not allowed
0 Maximum is strict fi Indicates the maximum value itself is not allowed

10. Click Save.

The Controls & Resources screen now liststhe input control.
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View~ Manage -

Add Report: New Complex Report

Controls & Resources

Locate the controls and resources used by your report.

Controls & Resources LT

Add Resource...

Data Source

Input Controls

Text Input Control Input Control
Add Input Control

Input Control Options

Display Mode:

Pop-up window | [] Always prompt

Optional 15P Location:

Remaove

(within /WEB-INF/j;

Copyright © Infogix, Inc




Adding a Simple Check Box Input Control

A check box input control accepts true/false (boolean) input from the user.

Toadd a simple check box input control to the complex report example,
complete the following steps:

1.
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Continuing with the previous example, on the Controls & Resources screen, click

Add Input Control.

On the Locate Input Control screen, select Define an Input Control in the next
step.

Click Next.

On the Create Input Control screen, select the type of input from the Type
drop - down: Boolean.

Enter the other properties for the input control.
A Prompt Textfi The label that the user sees next to the widget for this input

A Parameter Name fi The name of the parameter in the report that
receives the uservalue, such as CheckboxInput

Ensure that the correct parameter name is entered because the main JRXMLfile
references this name.

>

Description fi Optional setting that only displays within report wizard

b3

Mandatory, Read-only, Visible i A setting that affects how the input control is
displayed

Click Submit.

flINFO ﬁml:""i #& Lbrary Quicklinks View- Manage- Create~ admin | Log Out Q2

Add Input Control

Create Input Control

First, select the kind of input control you wish to add, then enter the required property values..

Type: \Buolean V|

Prompt Text (required):

Boolean Type

Parameter Name (required):

Boolean_Type

Description:

[] mandatory
[ Read-only
Visible

m Cancel

Copyright © Infogix, Inc. e

The Controls & Resources screen displays with the new check box input control.
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Adding a Drop-Down Input Control

The drop -down input control, also called a list input control, gives the user a
pre - determined list of choices. As a report designer, you make these decisions
about a drop -down input control:

A Topresent a single-select or multi-select listto the user
A Topresent a single choice as a drop -down listor a set of radio buttons
A

To present a multi-select control as a multi-select listor a set of check boxes

Radio buttons and check boxes usually work well for five or fewer choices.
This example shows how to create an input control that presents three choices
in a drop - down list. A list of values defines these choices. You can create a
new list of values dedicated to this input control, or you can use a listof values in
the Repository.

To add a drop -down input control to the complex report example,
complete the following steps:

1. Continuing with the previous example, on the Controls & Resources screen,
click

Add Input Control.

2. Onthe Locate Input Control screen, select Define an Input Control in the next
step.

Click Next.

4. On the Create Input Control screen, select the type of input from the Type
drop - down: Single-select List of Values.

5. Enter the other properties for the input control:
A Prompt Textfi The label that the user sees next to the widget for this input

A Parameter Name fi The name of the parameter in the report that
receives the user value, such as Listinput

Ensure that the correct parameter name is entered because the main
JRXMLfile references this name.

A Description i Optional setting that only displays within report wizard
A Mandatory, Read -only, Visiblefi A setting that affects how the input control is
displayed
6. Click Next.
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# Lbrary QuickLinks View- Manage- Creates admin | Log Out

Add Input Control

Create Input Control

First, select the kind of input control you wish to add, then enter the required property values..

Type: [Single-select List of Values v|

Prompt Text (required):

Sample

he label is displayed to users next to the input contro

Parameter Name (required):

Sample

his value must match the name of the parameter in your report.

Description:

[1 mandatory
[1 read-only
[ visible

Previous m Cancel

Copyright @ Infogix, Inc.

On the Locate List of Values screen, select Define a list of values in the next

step.

Instead of defining a list of values, you can use one in the Repository if its

values are compatible with the parameter defined in the JRXMLreport.

Click Next.
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9. On the Add Listof Values screen, enter a name, resource ID, and optional

description for the list of values. These properties are not visible outside of
the input control. Forexample, enter these values:

A Namefilist type
A Resource IDfilist_type
A Description fi Leave blank in this example.

10. In the Name Value panel, enter names and values to present as choices to the
user:

A Enter unique names.

The Reports interface requires uniqgue names to distinguish which item the
user chose.

A Enter values of the type that match the parameter definition in the
JRXML report. After entering a name and value, click Add . If you want to
remove a name, click Remove .

For example, enter:
o Name First Iltem with value 1.
o Name Second ltem with value 2.

o Name Third Iltem with value 3.

Stucie
Add List of Values

Add List of Values

Tdentily the list, then create the name vale pairs.

list type Namne

list_type

Third Item 3

11. Click Submit.

The Controls & Resources screen displays with the new Listinput control.

Adding a Date Input Control

Thisexample of adding a date input control usesa datatype that already
existsin the sample data in the Repository.

Toadd a date input control to the complex report example, complete the
following steps:




Onthe Controls & Resourcesscreen, click Add Input Control .

On the Locate Input Control screen, select Define an Input Control in the
next step, and then click Next.

On the Create Input Control screen, select the type of input from the
Type drop - down: Single Value.

Enter the other properties for the input control, using entries similar to
the examples below:
A Prompt Text fi Date Input Control

A Parameter Namef Datelnput

Ensurethat the correct parameter name is entered becausethe main JRXMLfile
references this name.

A Description fi Leave blank in this example.
A Mandatory, Read-only, Visible fi Checkonly the Visible setting.

Click Next.
flINFO %!Eﬁ A Lbrary Quick Links \View- Manage~ Creates admin | Log Out Q
Add Input Control
Create Input Control
First, select the kind of input control you wish to add, then enter the required property values..
Type: [Single Valus |
Prompt Text (required):
Date Input Control
Parameter Name (required):
Date_Input_Control
Nescriptinn:
[ Mandatory
] rRead-only
Visible
Copyright @ Infogix, Inc.

Onthe Locate Datatypes screen, select Select a Datatype from the Repository .
Click Browse.

In Select Resource from Repository, navigate to the InputDataTypes folder, and
select DateTime Datatype .

Click Select.
The Locate DataTypes screen shows the location of this datatype in the Repository,

/InputDataTypes/DateTime.
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Bl root

Sl Infogix

{5al Common
{5l InputDataTypes

DateTime Datatype

Text General Datatype

Select Cancel

10. Click Next.
The Controls & Resources screen displays with the new Date Input Control.

Adding a Query-Based Input Control

A query -based input control presents a dynamically -created listof choices to the
user. The Reports interface performs a query, and those results are used to create
the list of choices. You must perform the following tasks:

A Configure the query.
A Designate how to display the resultsin the input control.
A

Specify the value to pass as the corresponding parameter.

To add a query-based input control to the complex report example,
complete the following steps:

1. Onthe Controls & Resourcesscreen, click Add Input Control .

2. Onthe Locate Input Control screen, select Define an Input Control in the next
step.

Click Next.

4. On the Create Input Control screen, select the type of input from the Type
drop - down: Single-select Query.
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Enter naming properties similar to the following examples for the input control:

A Prompt Text i Query Input Control
A Parameter Namef Querylnput

Ensure that the correct parameter name is entered because the main JRXML

file references this name.
A Description fi Leave blank in this example.
A Mandatory, Read-only, Visible i Usethe default settings in this example.
Click Next.

fiIINFO gmgiﬁc! # Lbrary Quick Links View- Manage~ Create admin | Log Out

Add Input Control

Create Lnput Control

First, select the kind of input control you wish to add, then enter the required property values..

Type: [Single-select Query, v

Prompt Text (required):

Query Input Control|

Parameter Name (required):

Query_Input_Contrel

Description:

[ Mandatory
[ read-only
Visible

Copyright @ Infogix, Inc.

The Locate Query screen displays. Options are:

A Define a Query in the next step

A Select a Query from the Repository
For this example, select Define a Query in the next step.

Click Next.
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#A Library Quick Links View- Manage~ Create~ admin | Log Out

Add Query

Locate Query

© Define a Query in the next step

(O Select a Query from the repository

Previous Next Cancel

9. On the Name the Query screen, enter naming properties for the new
query. For this example, enter testQuery in both the Name and Resource
ID fields.

Copyright © Infogix, Inc,

fIINFO ﬁn!:ﬂ‘: # Lbrary QuickLinks View~ Manage~ Create~ admin | Log Out

Add Query

Locate Query

® Define a Query in the next step

O Select a Query from the repository

Previous Next Cancel

Copyright & Infogix, Inc.

10. Click Next.

The Link a Data Source to the Report screen displays. Options are:

Do not link a data source

A
A Click here to create a new data source

A Select data source from Repository

For this example, select Do not link a data source to use the same data source for
the input control as you use for the report. You will select the data source for the

7

report in 0Selecting a Data Source for Running the Complex Report. 6




il INFO pcmrl:gﬁ # Llibrary Quick Links View» Manage~ Create~ admin | Log Out

Add Query: test query

Link a Data Source to the Query

Optionally, link a data source to the query. You can choose a data source from the repository or create a new one.

® Do not link a data source
Name the Query b

* Link a Data Source

Define the Query O Select data source from repository

Previous Next Cancel

Capyright © Infogix, Inc.

11. Click Next.
12. On the Define the Query screen, select SQLfrom the Query Language drop -down.

13. Enter a Query String similar to the following example to retrieve the labels
and values to be displayed for this input control:

SELECT user_name, first_name, last_name FROM users

flINFO FGEEERF[ #& Lbrary QuickLlinks View~ Manage~ Create~ admin | Log Out Q

Add Query: test query

Define the Query

Select a language and enter the query

Neme the Query  Query Language:

Link a Data Source
Query String:
SELECT user_name, first_name, last_name FROM users

s Define the Query

Previous m Cancel

Copyright © Infogix, Inc.

14. Click Save.
The Set Parameter Values screen displays.

15. For each row in the results of the query, the Reports interface presents a
single value, such as Sarah Smith, in the input type widget (drop -down,
radio buttons, multi-choice, check boxes). On the Set Parameter Values
screen, name the database columns to comprise the input value
presented to the user. The column names must match those inthe SELECT
clause of the query string exactly.

Based on the example used in step 14, create database column names as follows:
a. InValue Column, enter user_name.
b. In Visible Columns, enter first_name.
c. Click Add.
d. In Visible Columns, enter last_name.
102




e. Click Add.

For each visible column that you want to display as a choice, enter
the name, then click Add. If you need to remove a choice, click
Remove . The following example shows the Set Parameter Values
screen.

flINFO lel::ae: # Library Quicklinks View- Manage- Create~ admin | Log Out Q

Add Input Control

Set Parameter Values

Provide parameters for the value column and any other columns you want to appear in the input control.

Value Column

user_name (required)

Visible Columns
first_name Remove

last_name Remove

last_name Add

Previous m Cancel

Copyright @ Infogi

16. Click Submit.

The Controls & Resources screen displays all the resources, including the new
input controls.

Next, set the input control options, asdescribed in the next section.

Setting the Input Control Options

In this procedure, you set the display mode in Input Control Options at the bottom of
the Controls & Resources screen. These options only display after you add an input
control to the report.

To configure the appearance of the input controls for the complex report
example, complete the following steps:

1. Select Pop-up window in the Display Mode drop-down field.

You can also select Separate screen to display the input controls in a separate
browser window, Top of screen to display them above the report, or In screen to
display them on the side of the report.

2. Select Always prompt when you want the Reports interface to display the
Input Controls dialog to prompt the user when the report runs.

z/ The definition of input controls in this example specified Visible and not Mandatory.
When input controls are not mandatory and Always prompt is not checked on the
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Controls & Resources screen, the user must click the Options button in the Report
Viewer to change input controls. Otherwise, the report runs with default input controls.

3. Leave Optional JSP Location blank for this example.

You can use the Optional JSPLocation option to specify the path toa JSPfile
that affects the appearance of the input controls.

flINFO ﬁngil’\'cz # Library Quick Links View- Manage- Create~ admin | Log Out Q

Add Report: New Complex Report

Controls & Resources
Locate the controls and resources used by your report.
Controls & Resources
Text Input Control Input Control Remove

Boolean Type Input Control Remove

Resources

Sample Input Control Remove
Date Input Control Input Control Remove
Query Input Control Input Control Remove
Add Input Control

Input Control Options

Display Mode:

Pop-up window V| [] Always prompt

Optional JSP Location:

Capyright ® Infogis, In

Select the data source to finish the complex report example.

Selecting a Data Source for Running the Complex
Report

Select a data source to retrieve data for the report and the query input
control; otherwise, the report and the listof usersin the query input control will be
blank.

Toselect a data source and run the complex report, complete the following steps:
1. On the Controls & Resources screen of the Report wizard, select Data Source.

2. Onthe Link a Data Sourceto the Report screen, choose Select data source from
Repository .

Click Browse and navigate to the data source you want to use.
Click the Select button.

On the Linka Data Source to the Report screen, click Submit.
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Select Data Source from Repository

B4 root
{5l Infogix
il Admin
il AVIDEMO
Bl DataSources
fal DataViews
Pl Organizations

(Sai Public

Skip the Query and Customization screens of the Report wizard to use the
default settings on those screens.

The Reports interface validates the report and a message displays indicating
that the report was added to the Repository. The new complex report
displays in the Repository.

In the Repository, click the name of the new complex report to run and
view the report.

Input controls display.

Enter input values similar to the following:

a. Text Input Control : myText

b. Checkthe Check Box Input Control check box.

c. List Input Control: Select Third Item.

d. Date Input Control: Click and select December 31, 2010.

e. Query Input Control : Select Sarah Smith from the drop -
down. The below screenshot displays these completed
fields.




Input Controls

Text Input Control :

myText

[V Check Box Input Control

List Input Control :
] Third ltem =

Date Input Control :
2010-12-31 @

Query Input Control :

{INULL] i
[NULL]

| Administrator

Jim | Brennan

Emil | Marinescu
e Vital | Rahman
Sally | Bronsen
Max | Jensen
Will | Westin
Chris | Olliver
Beth | Sasseen
Kristen | Verona
Jaime | Mesquite
Matt | Dominic

8. Click OK or Apply to run the report with the selected input, including the incorrect
non-numerical input for the Text Input Control field.
The Reports interface enforces the proper format defined for each input
control. You defined the Text Input Control as a numeric type, so it accepts
only valid numbers. The message indicates to specify a valid float number,
as the following example displays.

Input Controls

Text Input Control :

myText
i Specify a valid float number.
[V Check Box Input Control

List Input Control :
[ Third tem =l

Date Input Control :
2010-12-31 =

Query Input Control :

{Sarah | Smith i~

m OK Reset Cancel Save
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9. In Text Input Control, enter 3and click OK or Apply again.

The sample report includes a header that displays the value of each parameter
received from the input controls. Values and labels for the input controls also
display.
In the Report Viewer, you can open the Input Controls dialog at any time by
clicking the Options button. Click OK to run the reportusing the chosen values and
close the Input Controls dialog. Click Apply to run the report using the chosen
values, but keep the Input Controls open for choosing othervalues and re-running
the report.

If you get an error when you run the report, open it for editing as described in
OEditing JRXMLReport Units. dreview your settings. If you cannot find the problem,
edit the sample report (in the Repository at /reports/samples) and compare its
settings to your report.

To see the message written by the scriptlet JAR on the last screen of the report,
click

»

in the Report Viewer.

Adding Cascading Input Controls to a Report

JRXML:-based reports can include input controls that have dynamic values. The
values depend on a user'sselection in other input controls.

For example, a report has input controls for country, state, and city. The options
in the State input control depend on the value selected in the Country input
control. When the user selects a state, the list of values includes only those in
the selected state. These cascading input controls use queries to determine the
values to display in each input control field.

To use input controls as parameters for a query that populates another input
control, use a special syntax to reference a parameter name inthe input control's
guery. The syntax isidentical to the $P{parameterName} syntax used in queries
for Reports. For more information about defining the input ¢ o nt rgodryd see
0Adding a Query -Based Input Control . 6

For example, a report returns data identified by country and city. It includes
input controls called COUNTRYand CITY. Thiqquery used by the CITYinput control
retrieves city names from a table called accounts based on the value selected

by the COUNTRY input control:
select city from accounts  where country = $P{COUNTRY}

When the user selects a country from the COUNTRY input control, the value
selected is used by the query of the CITY input control; the CITY input control
is refreshed to show the result. Note that there are other ways to use a parameter
in a query.
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Editing JRXML Report Units

After you add a report unit to the Repository, you can edit any of its elements,
including file resources and input controls. Thisexample modifies the display text
of the ambiguous TextInput Control.

Toedit the complex report example:

1. Log into the Reports interface as an Administrator and click View > Repository .

@ If you log in as a user, you can edit a report that you created. This example
requires an Administrator login because an Administrator created the
complex report.

2. Search or browse the Repository to locate the report. In this example,
navigate to

Organization > Reports > Samples.

3. Right-click the New Complex Report and select Editfrom the context
menu. The Report wizard opens the report unit.

4. Navigate to the screen of the wizard for making the change; in this example,
click

Controls & Resources.

5. Make changes to an input control prompt and the display mode of the
input controls, for example:

a. Click the name of the Textlnput control.

The Locate Input Control screen shows that this input control islocally
defined.

b. Click Next.
The Create Input Control screen displays.

c. Change the contents of the Prompt Text field to enter a number.

The Locate Datatypes screen displays. You can select a different
datatype from the Repository. Forthis example, acceptthe existing
datatype setting.

d. InLocate Datatypes, click Next.

e. In Set the Datatype Kind and Properties, click Save to accept the
datatype property settings.

6. On the Controls & Resources screen:
a. Changethe Display Mode to In Screen.
b. Clearthe Always prompt check box.
c. Click Submit.

7. Runthe new complex report again.

Instead of displaying in a pop -up before the report; the input controls display in
the Options panel of the report.
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The next prompt,

Enter a number,

now displays for the text input control.

Because none of the input controls in this example are required, the report can
display with blank input controls. Enter values and click Apply to modify the report
output according to your input.

November, 2002

Sales By Month Report
Checkbox checked

List itermn 1

User admin User

N&W 600.00
Q&D 1900.00
Wolter-Colling 16830.00

Rutiedge 1100.00
Camparry

MEY 1330.00
BE&D' 1930.00
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Localizing Reports

You can adapt reports to global audiences by localizing input controls and field
names:

A Input controls i The Reports interface supports multi-lingual prompts and
static listsof values in reports.
A Field names fi The Reports interface supports multi-lingual field names in reports.

A $R expression that you write in the report design triggers linguistic changes in
the report output for different locales. Each $R expression refers to a name -
value pair (your translations) in a resource bundle. A resource bundle file isa text
file that has a

.properties extension. You create a resource bundle in Studio or a text editor. You
set the base name of the resource bundle in the header of the JRXMLfile:

<jasperReport name=0StoreSalses@enWi dth=05¢5@&enHei ght =08420
columnWi dt h=05150

| eft Mar gi nr=iogdl0toMar gi n oPM@ad gi nbo6BOOMMargi n=0500

resourceBundl e=0si mpleTabl eo>

For example, simpleTable is the base name of the resource bundle file for this
report. If you prefer using a graphical user interface to coding in XML, use Studio
Designer to setthe base name of the resource bundle.

Running a Localized Report

This section explains how to run the Romanian version of the complex report
you previously added.

Torun the Romanian version of the complex report, complete the following steps:

1. Choose the Romanian locale on the login screen of the Reports interface, and
log in as an Administrator.

2. Click View > Repository, and navigate through the folder structure to the folder
that contains the complex report you created, such as Organizations >
Organization > Reports > Samples.

3. Click the name of the complex reportyou
created. The Input Controls dialog displays.

4. Enter input control values similar to the following:

Text Input Control: 3

Checkthe Check Box Input Control check box.

List Input Control : Select Third Item.

Date Input Control : Click (], and select March 31, 2010.
Query Input Control : Select Sarah Smith from the drop-down.
Click OK.

-~ o 2 o0 T
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The fields in the title band and column names (sales person, sales account,
and sales amount) display in the language set by the Romanian resource
bundle: sales_ro.properties.

titte=Raport al v\ UOOE2nz \ u0103rilor lunare sales.person=Agent de
v\ UOOE2nz \ u0103ri  sales.account=Client
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sales.amount=Sum \ u0103 param.number=Num \ u0103r
param.date=Dat \ u0103

The currency and dates in the report output header then map to
Romanian locale settings.

Raport al vanzarilor lunare
Numar 3
Checkbox checked
List item 3
Data 31.03.2010
Query item sarah
User admin user
Sarah M & W 600,00
Q&D 1900,00

By default, the web interface elements display in US English when you
choose an unsupported locale, such as the Romanian locale. If you
choose a supported language, the web interface elements display in
that language. Supported languages are Chinese (Simplified), French,
German, Japanese, and Spanish. You can customize the Reports
interface to support additional languages. You can ftranslate the web
interface into a different language, Reports interface property names,
and messages in another language. For some locales, you may also need
to change the default locale and time zone.

Adding a Multi-Lingual Static List to an Input
Control

The Reports interface provides linguistic support for the list of values that an
input control can present to users. The input controls that can present a listof
values are:

>

Single-select list of values

>

Single-select listof values (radio)

A Multi-select list of values

A Multi-select listof values (check box)

The following example shows an example of a multi-lingual report. The prompts
and the multi-select list of values display in English or Spanish, depending on the
locale you select on the login screen.
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Controles de entrada

&

Ap

* Género:

Hembra

* Estado civil:
v Casado(a)
I Soltero(a)

* Departamento:

Direccion

Informatica
Estudios de Mercado
Recursos Humanos
Financiero y Contabilidad
Gerente (local)
Informatica (local)
Cajero (fijo)

Cajero (temporal)
Obrero (fijo)

Obrero (temporal)
Carnicero

Input Controls

4

Ap)

* Gender:

Female

* Marital Status:
v Married
O Single

* Department:

HQ General Management

HQ Information Systems
HQ Marketing

HQ Human Resources
HQ Finance and Accounting
Store Management

Store Information Systems
Store Permanent Checkers
Store Temporary Checkers
Store Permanent Stockers
Store Temporary Stockers
Store Permanent Butchers

The next example shows how to localize an input control that presents a single-
select listof values. The following tasks are explained step -by -step:

Edit a report to localize the listinput control. Tothe listinput control, add a

Upload the French resource bundle.

Add a multi-lingual static list of values to a listinput control.

Create a new resource bundle for the French translations.

Create a new resource bundle for the English translations.
Replace the existing Englishresource bundle with the new one.

Run the report that usesa multi-lingual listof values in an input control.

multi- lingual listof values for the US English and French locales.

To add a multi-lingual static list of values to a list input control,

the following steps:

1.

3.

folder.

Log into the Reports interface as an Administrator
the Repository named Temp.

Locate a report in the Repository to use. Select it and click Copy .

Navigate to the Temp folder and choose Paste. The report displays in the
Temp

complete

and add a folder to
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4. Select the reportin the Temp folder and click

Edit. The Report wizard displays.

5. Click Controls & Resources.

Thisscreen listsany input controls and resource bundles used by the report.

6. Click an input control to edit it.
7. InLocate Input Control, click Next.
8. On the Create

Input Control screen, change
an $R expression, such as $R{department_multi}.

the prompt text to contain

The following example shows the $Rexpression in the Prompt Text field.

Add Input Control

Brevious

Next

Create Input Control

First, select the kind of input control you wish to add, then enter the required property values.

Type: |Sing|e-select List of Values

Prompt Text (required):

=

| v

$R{department_multi}

The label is displayed to users next to the input control

Parameter Name (read-only):

ListInput

This value must match the name of the parameter in your report

Description:

Cancel

9. Click Next.

10. On the Locate Listof Values screen, click Next. The Edit List of Values
screen displays.

11. On the Edit Listof Values screen, click Remove to remove any existing name -

value pair.

12. Add name -value pairs containing $R expressions, similar to the following

example.

Name

$R{department_1}
$R{department_2}
$R{department_3}

Value
1
2
3
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The following example shows the edited list of values containing the
$R expressions in the name fields.

Edit List of Values

Edit List of Values

Identify the list, then create the name-value pairs.

Mame (reguired):

List of values label

Name Value

Resource ID (read-only):

List_of_walues $R 1 Remove
ra

Description: {department_

List of values description ;I 1}
$R 2 Remave

;I {department_

2}
$R 3 Remove
J{department_

3}

13. Click Submit.

The Controls & Resources screen shows the change to the input control prompt
The expression $R{department_multi}  replaces the original input control name
the list of input controls.

14. Click Submit again to save your work.

To create a new resource bundle for the French translations, complete the
following steps:

1.

In a text editor, create a new file for French translations, and enter name -
value pairs similar to the following example for the input control:
department_multi=Choisir le service department_1 = Travall # 1 department 2

= Travail # 2
department_3 = Travail #3

At the bottom of the file, enter field and property translations similar to
the following to localize the report:

titte=Rapport de ventes mensuelles sales.person=Commercial
sales.account=Compte sales.amount=Montant param.list=Liste Détaillée

Usethe Unicode escape sequenceif you cannot enter é: \u00e9

3. Save the file to your hard drive.
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Toupload the French resource bundle, complete the following steps:

1. Assuming you are stilllogged into the Reports interface, select the report in
the Temp folder you were previously editing, and click Edit.

Onthe Controls & Resourcesscreen, click Add Resource.

3. Select Upload a Local File, click Browse, and then locate the French
translation resource bundle file you saved on your hard drive. Select the file
and click Open .

4. InLocate File Resource, click Next.

On the Add a Report Resource screen, the French translation resource bundle
displays as the Selected Resource, indicating that the Reports interface
automatically detected it as a resource bundle.

5. On the Add a Report Resource screen, enter the name and resource ID.
Ensure that the resource ID matches the resource bundle file name exactly.

6. Click Next.

The Controls & Resources screen displays.

To create a new resource bundle for the English translations, complete the
following steps:

1. In a text editor, create a new file for English translations. Enter input
control name -value pairs similar to the following in the file.
department_multi=Select Department department_1=Work  #1 department_2=Work  #2

department_3=Work #3

2. At the bottom of the file, enter field and property translations similar to
the following to localize the report.
titte=Sales By Month Report sales.person=Sales person sales.account=Account
sales.amount=Amount

param.list=List item

3. Save the file to your hard drive.

To replace the old English resource bundle in the Repository with the new
one, complete the following steps:

1. Assuming you are still logged into the Reports interface and editing the
same report in the Temp folder, remove the old resource bundle file by
completing the remaining steps.

2. On the Controls & Resources screen, select the original English resource
bundle file.

Click Remove.
Click Add Resource.

On the Locate File Resource screen, select Upload a Local File. Click Browse
and locate the new English resource bundle file that you created in the
previous procedure. Click Open .

6. Click Next.

— — 116



On the Add a Report Resource screen, the new Englishresource bundle file displays
as the Selected Resource, indicating that the Reports interface automatically
detected it as a resource bundle.

7. On the Add a Report Resource screen, enter a name and resource ID.
Ensure that the resource ID matches the resource bundle file name exactly.

8. Click Next.

On Controls & Resources, click Submit.

At this point, the reportdoes not run because the new Englishresource bundle
file does not contain name -value pairs for all parameters that the JRXML
defines. In the next steps, you will remove these parameters from the report.

Torun the report that usesa multi-lingual listof values, complete the following
steps:

1. Click LogOut. On the Reports interface login screen, click Show locale &
time zone, select the en_USEnglish (United States) locale, and log in to the
Reports interface as an Administrator.

2. Navigate to the Temp folder of the Repository, and click the name of a
report to run it.

The Report Viewer presents the report using English field and property names in
the report.

3. Click Options , and view the drop -down field
options. The prompt and list of values display in
English.

4. Log out, and on the Reports interface login screen, click Show locale & time
zone, select the fr_French locale, and log into the Reports interface as an
Administrator.

5. Navigate to the Temp folder of the Repository, and click the name of a
report to run the report.

The report output includes the French report title, field, and property names
defined in the resource bundle. The Reports interface formats the currency
using a comma instead of a decimal point to separate Euro cents from dollars.
Translation packs and resource bundles installed with the Reports interface
for the French locale are used to format currency and dates and to
translate web interface components.

6. Click Options and view the drop -down field options. The input control prompt
and static list of values display in French.
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Rapport de ventes mensuelles
Liste Détaillee 1

Sarah M & W 500,00
O&DI 1900,00
Wolter-Collins 1630,00
Sally Rutledge 1100,00
M &Y Planck 1330,00
Masx B&D 1030,00
B & D Wolter 1930,00

The following example shows the input control prompt and static list of
values in Englishand in French.

Input Controls Input Controls

r "
* Select Department : * Choisir le service :

Travail £ 1 o

Travail # 2
Travail # 3

Apply . 0K Reset Cancel Save Appliquer OK Réinitialiser Annuler

Reusing Resource Bundles

The location of a resource bundle determines its capability for being reused
and conditions under which the server uses it. To resolve a $R expression in a
report, the server scans resource bundles at two levels in the order described in this

table.
Order Level Description
1 Report/ A report -level bundle declares the resource bundle base name in the

Repository| header of its JRXMLfile. The Romanian resource bundle is a report -
level bundle. A Repository-level bundle is independent of any specific
report and can be linked to multiple reports.

— — 118



2 Server A server-wide bundle typically contains server messagesand labels of
user interface components. This bundle typically resides in the WEB
INF/bundles directory of the server.

First, the server searches the report/Repository level and stops scanning
resource bundles if it finds a resolution to the $R expression. If the server does
not find a resolution, it scans the server level for the resource ID of the field and
usesthis ID.

Using Default Fonts in Reports Interface

By default, there are three fonts you can use in reports:
DejaVu Sans
DejaVu Serif

A DejaVu SansMono

Using the default DejaVu fonts ensures availability of fonts in all environments;
the PDFis pixel-perfect every time.

A
A

The DejaVu fonts replace the following Java logical fonts used in previous releases:
A SansSerif

A Serif
A Monospaced

@ SansSerif, Serif, Monospacedcan still be used, but are deprecated because these

Java logical fonts map to different TTFfiles in different environments, and run the

risk of text being cut when exported to PDFdue to font metric mismatches. Also,

these Java logical fonts are not recognized by some browsers, resulting in font

substitutions. For example, Firefox in a Windows environment renders the
SansSeriflogical font as Serif.

When using the DejaVu fonts coming from Reports font extensions, you need not
set any other font attributes (such as the pdfXXX attributes) in the JRXML or
specify font mapping. The font extension file that makes these fonts available sets
font attributes and mapping.

Formore information about DejaVu, refer to its SourceForge project

at: http://dejavu -fonts.org/wiki/index.php?title=Main Screen

@ Whenyou upload a TrueType font to the Repository, the file name must include the
correct extension (.TTF).

Using Studio with the Reports Interface

Studio allows you to create sophisticated layouts containing charts, images,
—_— 119



http://dejavu-fonts.org/wiki/index.php?title=Main_Page

subreports, crosstabs and much more. You can access your data through JDBC,
TableModels, JavaBeans, XML, Hibernate, CSV, and custom sources, and then

publish your reports as PDF, RTF XML, XLS, CSV, HTML, XHTML, text, DOCX, or
OpenOffice.

Connecting to Perceive

In order to connect Studio to Perceive, you need:

)

Perceive URL(http://<server>:<port>/infogixperceive/reports/)

)

Credentials to access Perceive

The RESTAPI has replaced the SOAP API for communication
and Perceive. When establishing a connection between
Perceive 9.0, you must perform the following steps:

between Studio
Studio 6.1.0 and

1 Change the URLin the JasperReports Server Access Configuration to:

http://<server>:<port>/infogixperceive/reports/

1 Clear the checkbox for the 6 U sS®AP protocol
Advanced Settings section.

o n | gption in the

To connect Studio to Perceive, complete
1. Open Studio 6.1.0.
2. Click the Repository Explorer tab.

the following steps:

e

3. Click the Create a JasperReports Server Connection icon.

? Jaspersoft Studio Pm—fﬁsw

File Edit View Mavigate

|t - ‘%v
L

Project Window

ol & 4

B2 Repositor &7

L Project Ex

= O

)

L
[ ]

[

[

= Data Adapters
; One Empty Record
= Sample DB
Servers

Enter the URL,username, and password for the server.
Click Test Connection .

Click Finish if the connection issuccessful.
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ﬂ Server profile wizard

JasperReports Server Access Configuration
Configure server connection

MName INWQA

URL  http://ivwga:8580/infogixperceive/reports/

Account

Organization

User admin

Password oooo.|

- Advanced Settings

JasperReports Library Version ’Same version with server ¥

Connection Timeout [ms] 50,000
[CIHTTP Chunked Requests Supports DateRange Expressions

[7] Use Single Sign On

Format of Attachements MIME

Workspace Folder
Locale
Time Zone

Settings | Info

[T]Use SOAP protocel only  [] Synchronize DataAdapter Properties

@j Test Connection ] [ Finish

|| Cancel

The server appearsin the Repository Explorer tab.

E Repository Explorer &3 [t Projs

Data Adapters

H Domain JRS

| One Empty Record
One Empty Record
Sample DB

[}

H

Sample DB

(R

Training Data Adapter

1Y
L

EMVErs

= IVDEVBANG

> |l IVWQA

= JasperReports Server Pro

v

v

e

= JasperReports Server Pro

v

= Training Server

Connecting Studio to Perceive (Using https)
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Connection
(https) connection

to Perceive

needs valid certificate

reporting application

using Studio 6.1 with secure
in Studio. Thiscertificate must be issued

to domain running InfogixPerceive application.

The following are the steps to import certificate:

1. Close Studio 6.1 application

if running.

2. Copy valid certificate to some export folder.

3. Copy the following studiolmportCertificate.bat script file

to some temp folder.

@echooff

IF%1.==.
echo Pleaseprovide alias for certificate.
echo "Usage: studiolmportCertificate

file>"

goto:eof

)
SETISS_ALIAS=%1

ECHCQalias provided : %JSS_ALIAS%

IF %2.==.

echo Pleaseprovide certificate location.
echo "Usage: studiolmportCertificate

file>"

goto:eof

)

SETCERT_FILE=%2

<alias-name> <full path to certificate

<alias-name> <full path to certificate

ECHOValidating locate of certificate file : %CERT_FILE%

IF NOTEXIST'%CERT_FILE%"

echo "Could not locate certificate file."
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echo "Pleaseprovide path to certificate file."
echo "studio import certificate failed."

goto:eof

)

ECHOVvalidating location of JSS HOME%JSS_HOME%
IFNOTEXIST'%JSS _HOME®%"

echo "Pleaseset JSS_HOMIo jasper studio home folder..."

echo "studio import certificate failed."

goto:eof

)

SET JSS_HOME_FEATURES=%JSS_HOMEHes

ECHOVvalidating JSSfeatures : %JSS_HOME_FEATURES%
IFNOTEXIST'%JSS_HOME_FEATURES%"

echo "JasperSoft Studio not installed correctly.Please verify studio installation
folder..."

echo "studio import certificate failed."

goto:eof

)

SET
JSS_JAVA HOME=%JSS HOME%/features/jre.win32.win32.x86_64.feature_1.7.0.u80

IF NOTEXIST'%JSS_JAVA_HOMEY"

echo "Missingstudio jvm location..."

echo "studio import certificate failed.

goto:eof

)
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"%JSS_JAVA_HOME%/jre/bin/keytool"-importcert -v -file "%CERT_FILE%Hoprompt -
alias %JSS_ALIASY%eystore "%JSS JAVA HOME%/jre/lib/security/cacerts" -storepass
changeit

IF %errorlevel% GEQL (
echo "studio import certificate failed."
) else (

echo "Certificate imported to Japsersoft studio client application."

)

Runwi nodw<®snma R d o mpagplitation as an Administrator and
navigate to the temp folder.

Set JSS_HOMEenvironment variable and point to JapserSoft Studio
installation folder.

Set JSS_HOME=fuHlpath -to -studio -installation -folder

Run studiolmportCertificate.bat script as following
studiolmportCertificate ~ some -alias-name full-path -to -certificate -
file

0Cer t i impoctedt te Japsersoft studio client ap p !l i ¢ amessage. 0
should be displayed on successful run.
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Start Studio 6.1 application.

8. Create a connection to perceive reporting server using secure

connection  (https).
9. Click Test Connection .

Successfulmessage

popsup.

Creating a New Report

Studio provides the option to create a report from scratch, add your own
templates, or use one of the supplied templates. All of these options allow you

to specify your data source. You have three data source options:

A One Empty Record - Empty rows: Thisis default data adapter

used to

create a report without any data. It can be used to define the layout of
a report before connecting it to a data source. A data source can be

added or changed at a later time, after the creation of a report.

A Sample DB - Database JBDC Connection: Thisisa SQL database
provided with the Studio installation.

A Creating a new data adapter: Studio supports a wide variety of data

sources. The
New button allows you to browse and connectto an existing data source.

Tocreate a new report, complete the following steps:

1. ChooseFile > New > Jasper Report.
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p Jaspersoft Studio Professional

-

Edit Navigate Project Window Help

Conwvert Line Delimiters To
Print...

Switch Workspace
Restart
Restart

Import...
Export...
Export as Report Template...

BB C. B

Export Files to..
Properties
1 Cherry_Landscape.jreml [MyReports]

Exit

MNew Alt+Shift+MN »
Open File...

Close Ctrl+W
Close All Ctrl+5Shift+W
Save Ctrl+5
Save As...

Save All Ctrl+Shift+5
Revert

Move...

Rename... F2
Refresh F5

Ctrl+P

Alt+Enter

i N0

[
(=3

]

|

Jasper Report
Style Template File
Data Adapter

Project...

Other... Ctrl+M

The New Report Wizard pop -up window appears.

2. Select Blank A4 and click Next.
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./ New Report Wizard

Report Templates

Please select a report from a template

Zoom: D

>

[ m |

Blank A4 Blank A4 Landscape Blank Letter Blank Letter Landscape

* Coffee Title
T :
I e

e ————————————

* Coffee Titke

Cherry Cherry Landscape Coffee Coffee Landscape -

@)

The New Report Wizard pop -up window appears.

Select the folder in the workspace where you want to save the report. You
can use the default folder MyReports .

Enter a name for the report in the File Name field. In this example,
use Domainbasedreport.

Click Next.

|/ New Report Wizard (=Nl
Report file

Please select your reports file name with .jxml extension.

Enter or select the parent folder:
MyReports

=% MyReports

File name: Domainbasedreport.jrxml

@ [ <Back [ Net> [ Finish ][ cancel |

The Domainbasedreport.jrxml  appears.
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6. Click the DataSet and Query editor dialog icon.
Jaspersot Studio Professional . 4 . M— —— T [ |
File Ed View Nevgete Project Window Help
3 USRS ST a8 S A =]
B Repostor 13 s Progectx] O Domainbasedrepodynmi 2 O 0|3 pulette 13N st
5 2 [EWenReer) a8l aa |l setings - B
& Data Adapters PR T R [, I RS 800 < 1086 400+ e e s 500 4 o o N A [ Elements q
+ Wiz Il Lk iad i ctectnky | 5 Nete
- g ° I Tot field
o Static Tet
& Imsge
ra—
" Tooks 3
§ ¥ Page Number
3 T Total Pages
- (13 Current Date
[} Time
; _amn e 2t
& (] Components Pro
: @ HTMLS Charts
- TP Maps Pro
3 P ChantsPro
8 © vidgets Pro

D propent 75 Protle | =

: @ e

: Propety:.. | Vebi
2
¢
% outine 71 =0l
4 3 Domsinbesedreport &
/ s
5. Parameters 2
" Fields
Scrt Fields.
S Vacubles -
= Scriptiets
4 Tale
=t Page Hesder i
% Column Heades 2
=t Detail [125px] &
24 Column Footer =
it Page Footer g
= Background
=8
Preview: Chemry_Landscape on

The Dataset and Query Dialog pop -up window appears.

7. Select domain from the Language drop-down.
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./ Dataset and Query Dialog @@g

=] OneEmptyRecord ¥

| Query| Java Bean |

Language E08 I:] Read Fields

[
caL B1 .

CSsv

| domain |

ejbql

HiveQL

HQL

JSON

mdx

MongoDbQuery

plsql 4

sl esh. |»

SQL
‘ xls

xlsx
xPath

xpath2

1

< »

Text' Outlinei Diagram

Field Name Class Type Description
jFieIds‘ Parame’(ersl Sorting | Filter Expression | Data preview |
@ [ ok ][ conce |

8. Selectthe required server from the listof active serversin the Server drop -down.

9. Select the required domain corresponding to the selected server in the
Domain
drop -down.

The list of available sets appears under the selected domain.

10. Drag and drop the required sets/fields. In this example, select IV_EMPLOYEE.
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&/ Dataset and Query Dialog I

Z  one Empty Record ¥

Query ! Java Beanf

Language domain v

Server [ivsql '] Domain [/Infogix/Common/ShowAndT ell_Demo/Domain/EmployeeDetails

|ln] . 4 [T Fields
» [[[] V_EMPLOYEE| [7] IV_EMPLOVYEE salary
[in] [T} IV_EMPLOVYEE.hiringdate
]:| IV_EMPLOYEE.gendar
[C] IV_EMPLOYEE.empname
[C] IV_EMPLOYEE.empid
lq [7] V_EMPLOVYEE.deptid
i, [T Filters
|
Text | Design |
Field Name Class Type Description

Fie[ds‘ Parameters | Sorting | Filter Expression | Data preview |

®

OK ] [ Cancel

11. Click Get Fields. The selected fields appear in the Fields tab.

12. Click OK.

|

&/ Dataset and Query Dialog

ey

& one Empty Record v
Quevy‘ Java Bean]
Language domain v Get Parameters
Server{ivsql v] Domain [/Tnfogix/ ShowAndTell_Demo/Domain/EmployeeDetails v]
I "4 [T Fields
» [ IV_EMPLOYEE [T} IV_EMPLOVYEE salary
[C] IV_EMPLOVYEE hiringdate
D IV_EMPLOYEE.gendar
D IV_EMPLOYEE.empname
[[] IV_EMPLOYEE.empid
[C] IV_EMPLOYEE.deptid
|4 =
» [T Filters
Text [ Desion|
v
Field Name Class Type Description
IV_EMPLOVYEE.salary java.math.BigDecimal salary
IV_EMPLOYEE.hiringdate java.util.Date hiringdate
IV_EMPLOYEE.gendar java.lang.String gendar
IV_EMPLOYEE.empname java.lang.String empname
IV_EMPLOYEE.empid java.math.BigDecimal empid
IV_EMPLOVYEE.deptid java.math.BigDecimal deptid
Fields | Parameters | Sorting | Filter Expression | Data preview |
@ ok [ cancel
i

13. The selected fields appear inthe Outline view.
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Fie_Edt : View Navigate - Project - Window - Help

inriQ® Q38w i 0K

B reposter 31 B popaid] B8 BN

1[5 palette 57 =0
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© & Data Adapters W e T TS T TR T

4 g Servess
» el
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5
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2 Note
lethed
e Statx Tert
& Image
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T Total Pages
[ Current Date
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@ HTMLS Chans
9 Maps Pro
@ ChansPre
© widgets Pro

O propert 2 O Prodle | ' £F

7

Re..rt | SearchProperty -

(R ppece ]

Language ooy <
¥ |

Format Factory Class

Whea o e Type [NoPages

1 Title On A New Page |

17 Summary On A New Page

1 Summary With Page Heades And =

[ flcat Column Focter

I Ignere Pagination

~ Dataset

When Resource Missing Type [y_‘

Design  Source Preview|
' Report State :o?\‘_
Console Ermors Statistics.

Serplet Class
Resource Bundie

14. Drag and drop the fields to the Designer Report.
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Note:

If you encounter

the following error message when executing reports in

Studio (right-click the report unit and click Run Report Unit), complete the
following steps:

B Repository Explorer 52 ({4 Project Explorer | 51|(ad Blank_A4_47joml |1 SVZMUUFCQUSH:/Infogix/StudioReportl... &2
E9R N e SR e giStudiof
£ Sample DB B
[ Sample DB
B Somplc b8 Error Page Exception
£ Sample DB
o Servers
e o 34FPL SRVEO0260E: The server cannot use the error page specified for your application to handle the Original Exception printed below.
» L Cloud
= IVDEVBAG 9080
> b IVLQAHTTPS ] Original Exception:
a4 | VLQABANG
4 [ Infogix Error M com.ibm.websp} ervlet session UnauthorizedSessionR (E ion: SESNOOOSE: A user authenticated as anonymous has
b [Z) Admin attempted to access a session owned by user:10.2.20.242:389/CN=psu.ou=Accounts.dc=playground.dc=local.
> [ Common Error Code: 500
> G DataSources Target Servlet: JerseyREST
> GaliStudioReporth » Error Stack:
S *: g\:i:’:ﬂm"s = com.ibm.websphere serviet session. Unautk dSessionR iD ion: SESNOOOSE: A user authenticated as has dto
S B Temp access a session owned by user:10.2.20.242:389/CN=psu,ou=Accounts,dc=playground.dc=local.
38 Theinés at com ibm. ws.session SessionContext.checkSecurity(SessionContext java:1400)
B IVWQ A 8580 at com.ibm ws.session SessionContext isValid(SessionContext java:903)
. L IVWQA_HTTPS_NEW at com.ibm.ws.webcontainer.srt. SRTRequestContext. getSession(SRTRequestContext.java:96)
: JaspeiRegorts ServerPio at com.ibm.ws.webcontainer.srt. SRTServietRequest. getSesswn(SRTSm’letRequest ]ava22 14)
at org springframework web.context request. ServietRs¢ A dateA ib ServietR Attrit java:215)
L at org.springframework. web.context request AbstractR Attrib requestCompleted(Ab R it java:48)
b - at org.springframework. web.context.request RequestContextListener requestDestroyed(RequestContextListener. java:80)
L J i’ at com.ibm.ws.webcontainer webaprp ‘WebApp.notifyServietRequestDestroyed(WebApp.java:1905)
E Outline 523 =5 at com ibm wsspi.webcontai -Collab Helper postlnvokeCollab Collab Helper java:532)
h outline is not available. at com.ibm ws.webcontainer filter. WebAppFilterManager invokeFilters(WebAppFilterManager java:1267)
at com ibm.ws.webcontainer.webaop. WebAop. handleR eauestWebAvo.iava:3951)
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1. Configure the Data Adapter.

=i

8
B

£ Data Adapters

£ Domain JRS
4 Servers
o 4FPL
Cloud
IVDEVBAG_9080
IVLQA_HTTPS
IVLQABANG
1 Infogix

[ Admin
> [ Common

| DataSources
> [ StudioReportl
» [/ Organizations
"I Public
> () Temp
> 1) Themes
L VWQA 8580
b Ll VWQA_HTTPS_NEW
> i JasperReports Server Pro

o

( sk Blank_A4 47 jocml

[ SVZMUUFCQUSH:/Infogix/StudioReportl... 52
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Error Page| vsta adspter
Domain JRS
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Original Exception]
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Error Message: com.ij ey, IVLQABANG
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Error Code: 500
Target Servlet: Jersey§ ;
ernarme | psu

Error Stack:
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pthenticated as anonymous has

L

A palettd

Paleq

com.ibm.websphere.sery
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at com.ibm.ws.sessiof
at com.ibm.ws.sessiof
at com.ibm.ws.webc
at com.ibm.ws.webc
at org.springframewof

@ Test <Back i

Successful

at org springframewo

2. Click the Preview tab

Data Adapter.

on the bottom of the jrxml file and select the required

E Repository Explorer | (7 Project Explorer 52
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a

Lai RRRRR jraml

a5 TestRepor

> & CVC
» & MyReports
4 & Training Demo

=) JasperReports Library
ol Ljnaml
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a1 BlankReport Testjnaml

&l BlankReportTest2 jrxml

ad Newjoml

a4 ReportNew,jnoml

a1 RRRRR jnem

al SampleL joml

sl Temp.joaml

sl Templjnaml

ad Test 1311 jeml

|ai Test Rep_19,jnml

ad Testljoaml

i Test2jmml

a1 TestReportjnaml

g Training_Domain_Report jasper
s} Training_Domain_Reportjrxml
w5 Training_Employeejasper

& Training_Employee jomi

» m JRE System Library [jre.win32.win32.436 64 feature 17.0.u2

£l OneEmptyRecord v Java v Pagelofl
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Training Data Adapter - Database JDBC Connection
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Design | Source | Preview

TestRepott
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3. Runthe report.
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Publishing a Report to the Perceive Repository

To publish a report to the Perceive Repository, complete the following steps:

1. Click the Publish Report icon in the upper right corner.

(2 tmspersoft Studio Professional — — =" ‘wg
Fde Edt View Nengate Project Window Help
£y~ Q- GEZ i a1
U8 Repostor &2 1L Progect&x| 0ol Doemainbasedreportjrml. £.3 = O[3 Palette 12
L 2 oot 8| & & 0% & sawq ~| -
$ Oots Adapters o 3 100 ) 20 ) ) ' 00 ' w0 R AN e A0 s | Elements "
4 o Servers 15 Note
= vl ° t
EMMOYEE IV EMPLOYEE. W CUPLOYEE I CMPLOYEE. IV EMPLOYEE IV EMPLOYEE Text Field
sty hengtaw enas: srename ot P s St o
SFIV_EMPLOYEE. BFIV_EMPLOYEE. SF{IV_EMPLOYEE. SF(IV_EMPLOYEE. SFIV_EMPLOYER, SFIV_EMPLOYEE
ke Nmgiaw) ponatey Sergameg vt ey & mage
" Tooks
8 # Page Number
: 1 Total Pages
[ Current Date
[ Time
& () Components Pro
@ HTMLS Charts
z @ Maps Pro
: @ Charts Pro
-] © Widgets Pro
T Propent ) Proble y
| -
Re..rt | Sesch Propenty -
2 [l Report | 1™ Appearamce [T Ach
57 Outline 11 %
2+ o, Domainbasedreport Feport Name Domanbase
7 Sryles . Langusge arocvy
Panametess g
« %7 Falds Impods
Foemat Factory Class
When NoData Type [ No Pages
8 Tale On A New Page
1 N_EMPLOVER deptd 3 Summary On & New Page
44/ Sort Frelds Summary With Page Header And g
Jx Vanables 2 Float Columnn Footes
e
= Scepliets Ignore Pagination
E Dataret
Column Header When Rescurce Missing Type |Null
Detad [30px] When Rescurce Missing Type
171 SE[V_EMPLOVEE sefary) . | 5
SEIIV_EMPLOVEE seary] Design [Sowee] Previes [| scrptet cians
17 SHIV_EMPLOVEE hiringdate | b !
1°1 SF{V_EMPLOYEE gendar) a4 Baport State 17 =] Resource Bundtie
1 SE{NV_EMPLOYEE emprame
- Console Emors Statistic
1 SF{V_EMPLOYEE empid) RN g Edit query, filter and sort optic
11 SF{IV_EMPLOVEE.deptid]}
Page Format
Page 3
Preview: Cherry Landscape on

The Report Publishing Wizard pop -up window appears.

2. Navigate the directory structure and choose the directory where you want
to store your report.

Enter a name in the Report Unit Label field.
Click Next.
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./ Report Publishing Wizard

Publish To JasperReports Server

Select JasperReports Server and location where report will be published

4 ivsql

4 || Infogix
& | Common
| DataSources
4 | | DataViews
b [ 3.2 test2
p [ ABC1

[ AK_ACRMF45_DV
|1 AK_ACRWB44_DV
b Mar
» [ Priya_ER
[ Ran
» || Robs Other DV
> [ Sample
4 || ShowandTell_EmpDetails
> || DataDomains
4 || Entities
4 || ShowandTell_Emp
» || DataDomains
cpors

. [ Uma_ER DV
> || VH_Assure_View
» || AVI_Data View

Create Report Unit

]

E|

Report Unit Label Domainbasedreport
Report Unit Name D)  Domainbasedreport
Report Unit Description

® < Back Next > Finish

5. The domain that was selected when designing the report automatically

populates as a data source for the report unit. Click Finish.

./ Report Publishing Wizard [ S

Configure the data source

Select the data source to use

@ Data Source from Repository
/Infogix/Common/ShowAndTell_Demo/Domain/EmployeeDetails

() Local Data Source

(") Don't use anv Data Source

@ Net> | [ Finish ] |

Cancel
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6. Ifthe report issuccessfully uploaded to the server, the Information pop -up
window appears. Click the OK button.

o/ Information ﬂ

Success!

The following resources where published on the JasperReports Server:
/Infogix/DataViews/ShowandTell_EmpDetails/Entities/ShowandTell_Emp/Reports/Do
mainbasedreport
/Infogix/DataViews/ShowandTell_EmpDetails/Entities/ShowandTell_Emp/Reports/Do
mainbasedreport_files/main_jrxml

7. The newly created report appears in the specified location in
the Repository.
IiIINFO’GIX A library View, Manage, New, ndmin | tog 0 | V)

Repository 5017 2¢: Name | Modified Date

O Neme Descriglion Crested Date Hodified Date
Avi_Dept_ChartTesting_view Report 2

Domainbasedreport

EmpDetails_TahleData

GraphTesting_View

GraphTesting_ViewReport Report March 19

R1 Report

vi Ad Moc View March 20
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Advanced Process Monitoring and Alerting

Process Dashboard

The Process Dashboard allows you to monitor and analyze the status of different
types of Perceive processes. The process information is stored in Perceive
database/internal target for reporting and analysis. You can drill down to the
detailed process execution from the high-level dashboard.

Perceive provides advanced monitoring features for the following processes:
 Extract

M1 Load

1 Report Run

Extract Process: The process to extract data from Assure DQ, ER or ACR
applications and save it in internal target (Perceive database) or external
target (external database). Thisprocess can be initiated by Assure control run
finish event, ERSOD/EOD complete event, or a scheduler.

Load Process: The process to load the extracted data from staging area to
Perceive database/internal target or external targetfor reporting and analysis. This
process can be initiated by auto -load setting in data entity.

Report Run Process: The process to start running report and generate report
output. Thisprocess can be initiated by completion of data loading or a scheduler.

View the Process Dashboard

The Process Dashboard contains three donutcharts for Data Extract process, Data
Load process, and Report Run process at a high level. Each chart shows count
for each process status: Completed, Failed, and Resolved (if rerun is true). You
can drill down these charts to view a listof process for each type.

To view the Process Dashboard, complete the following steps:

1. Navigate to root ->Infogix -> Admin -> ProcessMonitoring .

— — 138



i1 Folders

é] root
E|L_J Infogix
Et] Admin
Domain

InputControls

Reports
AVIDEMO

Commion
DataSources
DataViews
Domain_Reports

Organizations

Public

Temp

Themes

2. Right click ProcessDashboard and select Run.

HINFOGIX A ubmy Quklnks View- Manage. Creste- admin | tog ovt [N
) Folders Repository Sort By: Name | Modified Date
(Sl root Run  Edit Open Copy Cut Paste  Delete
Bal L"f"g'x ©  Name Description Type Created Date Modified Date
Sl Admin
Boman Run in New Tab
Inputcontrols Open in Designer.
Al Reports.
(5l AVIDEMO Copy
Common Cut
(Bl DataSources Delete
(5] DataViews Permissions...
Domain_Reports Properties
Organizations
Public Bt

The Process Dashboard appears with the all the process types by default
in the Dashboard Viewer.
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A lhean  Qucklkn Wew. Munage.  Cisins

Process Dashboard

Data Extract Process

Report Run Process

Data Load Process

Finfogix

3. Click Start Date to select the start date.
ProcessDashboard
* Start Date * End Date * Process Type m
po14-11-20 2015-11-20 All Q
o TIY ©
Mo Tu We Th Fr 5a Su
1 2
3 4 5 6 7 3 9
10 11 12 13| 14| 15 16
17 18| 19| 20|| 21| 22| 23
DashBoardReport
24| 25| 26 27 28 29| 30
Today Done

4. Click Done after selecting the start date.

5. Click End Date to select the end date.
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ProcessDashboard

2015-11-20 EE All Q

[« Novy 2015 ~ ]
Mo Tu We Th Fr 5Sa 5o

1
2| 3| 4| 5| 6| 7| &
9 10 11| 12| 13| 14 15

* Start Date * End Date * Process Type m
2014-11-20 = |l

16| 17| 18| 19| 20| 21| 22

DashBoardReport
23 24 25 2 27 28 29
30
Today Done

6. Click Done after selecting the end date.

7. Select the type of process from the Process Type drop -down.

ProcessDashboard

2015-11-20 E All

* Start Date * End Date * Process Type m
2014-11-20 = i

8. Click the Completed area (highlighted in green) in the Data Extract Process
donut chart.
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ProcessDashboard

* Start Date * End Date * Process Type m

20141120 2015-11-20 m Extract Q

DashBoardReport

HINFOGIX
Process Dashboard

Data Extract Process

Completed, 101~

Failed, 34

Resolved, 2~

5/ When you hover the mouse over each section in the donut chart, the
corresponding percentage is displayed. Input parameters such as time range and
processtype helps you to customize the display of DashboardViewer.

Process Details Report appears for Data Extract process with the specified
input parameters. It displays the details of all the processes with the
completed status.
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NFQ%E")UGE # Lbrary Quicklinks Views Manage» Creates

ProcessDetails  Dats refrashed Nov 20, 2015 at 3:10:24 AM §3

me B, B. = = 4 [100% 7] [seachepot Qx| 4 B Page [1 EE Y

November 20. 2015

NINFOGIX Process Details Report wi

Process Name Process Type Start Time Entity Name Entity Type Status

Exract CE_Assure Contral Data EXTRACT 0112016 CE Assure DATAWARE ENTITY  COMPLETED
Exaract Test!_GE Result Template Infogix EXTRAGT 10172015 Test1_CE DATAWARE_ENTITY  GOMPLETED
Extract Test1_GE Result Catalog EXTRAGT 11172015 Test1_CE DATAWARE_ENTITY  GOMPLETED
Exiract Test1_CE Control Data EXTRACT 10172015 Test1_CE DATAWARE_ENTITY  COMPLETED
Exiract DATACHECK_DE_NOVA0 Control EXTRACT 1012015 DATACHECK_DE_NOVID DATAWARE ENTITY  COMPLETED
Exrac: EMPLDATA_NQV1D Control Data EXTRACT 101112015 EMPLDATA_NOVID DATAWARE ENTITY  COMPLETED
Exaract CE_Assure Control Data EXTRACT 10172015 CE_Assure DATAWARE_ENTITY  COMPLETED
Exaract DE_GLAIMPAYMENT Historical Dats EXTRAGT 1112015 DE_CLAIMPAYMENT DATAWARE_ENTITY  GOMPLETED
Exiract DE_CLAIMPAYMENT Current Data EXTRACT 1112015 DE_CLAIMPAYMENT DATAWARE ENTITY  COMPLETED
Exiract DE_CLAIMPAYMENT Actiity Log EXTRACT 1 s DE_CLAIMPAYMENT DATAWARE_ENTITY  COMPLETED
Exraci DE_CLAIMPAYMENT Notes EXTRACT 141172015 DE_CLAIMPAYMENT DATAWARE ENTITY  COMPLETED
Exrac: DE_CLAIMFAYMENT Emails EXTRACT 14172015 DE_CLAIMPAYMENT DATAWARE_ENTITY  COMPLETED
Extract DE_GLAIMPAYMENT File Attschments. EXTRAGT 1112015 DE_CLAIMPAYMENT DATAWARE_ENTITY  GOMPLETED
Exaract DE_GLAIMPAYMENT Historical Dats EXTRAGT 1112015 DE_CLAIMPAYMENT DATAWARE_ENTITY  GOMPLETED
Exiract DE_CLAIMPAYMENT Current Data EXTRACT 1112015 DE_CLAIMPAYMENT DATAWARE ENTITY  COMPLETED
Exirac DE_CLAIMPAYMENT Actiity Log EXTRACT 101172015 DE_CLAIMPAYMENT DATAWARE ENTITY  COMPLETED
Exraci DE_CLAIMPAYMENT Notes EXTRACT 141172015 DE_CLAIMPAYMENT DATAWARE ENTITY  COMPLETED
Exaract DE_GLAIMPAYMENT Emails EXTRAGT 1112015 DE_CLAIMPAYMENT DATAWARE_ENTITY  GOMPLETED
Extract DE_GLAIMPAYMENT File Attschments. EXTRAGT 1112015 DE_CLAIMPAYMENT DATAWARE_ENTITY  GOMPLETED
Extract CLAIMPAYMENT_TEST! Histerical EXTRACT 1 15 CLAIMPAYMENT_TEST1 DATAWARE_ENTITY  COMPLETED
Extract CLAIMPAYMENT_TEST! Current Data. EXTRACT U015 CLAIMPAYMENT_TEST1 DATAWARE_ENTITY  COMPLETED
Exrac: CLAIMPAYMENT_TESTH Aciiviy Log EXTRACT 10112018 CLAIMPAYMENT_TESTI DATAWARE ENTITY  COMPLETED
Exrac CLAIMPAYMENT_TESTH Notes EXTRACT 14112015 CLAIMPAYMENT_TESTI DATAWARE_ENTITY  COMPLETED
Exarzc: CLAIMPAYMENT_TEST Emais EXTRAGT 1112015 CLAIMPAYMENT_TEST1 DATAWARE_ENTITY  GOMPLETED
Exiract CLAIMPAYMENT_TEST1 Fie EXTRACT 10112015 CLAIMPAYMENT_TEST1 DATAWARE_ENTITY  COMPLETED
Extract CLAIMPAYMENT_TEST! Histerical EXTRACT 1UN/2015 CLAIMPAYMENT_TEST1 DATAWARE_ENTITY  COMPLETED
Exrac: CLAMPAYMENT _TEST Current Data. EXTRACT 14112015 CLAMPAYMENT_TESTI DATAWARE ENTITY  COMPLETED
Exrac: CLAIMPAYMENT_TESTH Aciiviy Log EXTRACT 10112018 CLAIMPAYMENT_TESTI DATAWARE ENTITY  COMPLETED
Exaract CLAIMPAYMENT_TEST! Notes EXTRAGT 10112015 CLAIMPAYMENT_TEST1 DATAWARE_ENTITY  GOMPLETED
Exarzc: CLAIMPAYMENT_TEST Emais EXTRAGT 1112015 CLAIMPAYMENT_TEST1 DATAWARE_ENTITY  GOMPLETED
Extract CLAIMPAYMENT_TEST1 Fie EXTRACT 1UN/2015 CLAIMPAYMENT_TEST1 DATAWARE ENTITY  COMPLETED
Extract CLAIMPAYMENT_TEST! Histerical EXTRACT U015 CLAIMPAYMENT_TESTI DATAWARE_ENTITY  COMPLETED
Exrac: CLAIMPAYMENT_TEST Current Data. EXTRACT 14112015 CLAIMPAYMENT_TESTI DATAWARE ENTITY  COMPLETED
Exrac: CLAIMPAYMENT_TESTH Aciiviy Log EXTRACT 14112015 CLAIMPAYMENT_TESTY DATAWARE_ENTITY  COMPLETED
Exaract CLAIMPAYMENT_TEST! Notes EXTRAGT 10112015 CLAIMPAYMENT_TEST1 DATAWARE_ENTITY  GOMPLETED

Generate Daily Reports

You can define and preload Process Monitoring report event with daily calendar
run. The report event runs the following preload reports:

1 Aging Unresolved Report
1 Unresolved Report

These reports are send to the all the recipients defined in the report event.

View Aging Unresolved Report

Aging Unresolved Report displays the details of all the failed processes older
than certain days.

To view Aging Unresolved Report, complete the following steps:

1. Navigate to root ->Infogix -> Admin -> ProcessMonitoring -> Reports.
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i Folders

S root
5 Infogix
(5l Admin
Sl ProcessMonitoring
E‘, | Domain

E‘, | InputControls
E‘, | Common
E‘, | DataSources

(Flul DataViews

2. Right-click Aging Unresolved Report and select Run.

# LUbrary Quick Links View+ Manage- Creaste -

rame
DashBoardReport
ProcessDetalls

Unresolved Report
Aging Unresolved Report

Copy
Cut
Delete

Permissions...

Properties.

3. Inthe Input Controls window, click the drop -down to select the duration.

Input Controls

* Select Duration

All

[ Q|
All
12 Months

3 Months

Current Year

Apply oK Reset Cancel Save

4. Click OK after selecting the duration.
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Input Controls

* Select Duration

& Months

=3 -

Reset

Cancel

Save

Aging Unresolved Report appears for the selected duration.

It displays the

details such as process name and type, entity name and type, start time, and

the process status.

HINFOGIX

Aging Unresolved Report

MNeowember 20, 2015
D3:24

Process Name Process Type Start Time  Entity Name Entity Type Status
Extract Test1_CE Result Template Infogix EXTRACT 111015 12:24 AM Testi_CE DATAWARE_ENTITY FAILED
Exiract Test1_CE Result Template Infogix EXTRACT 111015 12:24 AM Test1_CE DATAWARE_ENTITY FAILED
Exfract EMP_MNOA18 Centrol Data EXTRACT 11716/15 407 AM EMP_NOW1E DATAWARE_ENTITY FAILED
Test Assure Source System TEST 11718/15 5:12 AM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System Assure event TEST 111815 5:18 AM Azsure SOURCE_SYSTEM FAILED
Extract EMP_DATA Result Catalog EXTRACT 11718/15 4:44 PM EMP_DATA DATAWARE_ENTITY FAILED
Extract EMP_DATA Control Data EXTRACT 117168/15 4:44 PM EMP_DATA DATAWARE_ENTITY FAILED
Extract CE_Assure Control Data EXTRACT 11717115 5:54 AM CE_Assurs DATAWARE_ENTITY FAILED
Extract DATACHECK_DE_NOWV1D Control EXTRACT 111715 2:25 PMDATACHECK_DE_MOV  DATAWARE_ENTITY FAILED
Test Assure Scurce System TEST 11717115 2-40 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System TEST 11717115 4:27 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System TEST 11717115 4:20 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System TEST 111715 4:21 PMDEFAULT_ASSURE_S  SOURCE_SYSTEM FAILED
Test Assure Scurce System TEST 11717115 5:41 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System TEST 1111715 11:22 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Extract EMP_Recruit Control Data EXTRACT T1117ME 11:40 PM EMP_Recruit DATAWARE _ENTITY FAILED
Test Assure Source System TEST 111815 2:50 PM DEFAULT_ASSURE_S  SOURCE_SYSTEM FAILED
Test Assure Scurce System TEST 11/18/15 2-58 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System TEST 11718115 3:13 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System TEST 11718115 3:20 PM DEFAULT_ASEURE_S SOURCE_SYSTEM FAILED
Test Assure Source System TEST 111815 3:25 PMDEFAULT_ASSURE_S  SOURCE_SYSTEM FAILED
Extract RECOMN_dE Control Data EXTRACT 11718/15 3:51 PM RECON_dE DATAWARE_ENTITY FAILED
Test Assure Source System TEST 1171815 10-03 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Extract RECON_dE Match Set Audit Report EXTRACT 1111915 11:34 AM RECOM_dE DATAWARE _ENTITY FAILED
Extract RECON_dE Match Set Audit Report EXTRACT 111915 11:24 AM RECON_dE DATAWARE_ENTITY FAILED
Extract RECOMN_dE Recon Task Report EXTRACT 1171915 11:34 AM RECON_dE DATAWARE_ENTITY FAILED
Extract RECON_dE Recon Task Report EXTRACT 1171915 11:34 AM RECIOM_dE DATAWARE_ENTITY FAILED
Extract RECON_dE Resulkk Temgplate Chetna EXTRACT 111915 11:24 AW RECON_dE DATAWARE _ENTITY FAILED
Extract RECON_dE Result Template Chetna EXTRACT 111915 11:24 AM RECON_dE DATAWARE_ENTITY FAILED
Extract RECOMN_dE Result Template Chetna EXTRACT 1171915 11:34 AM RECON_dE DATAWARE_ENTITY FAILED
Extract RECON_dE Result Template Infogix EXTRACT 1171915 11:34 AM RECIOM_dE DATAWARE_ENTITY FAILED
Extract RECON_dE Result Temgplate Infogix EXTRACT 111915 11:24 AW RECON_dE DATAWARE _ENTITY FAILED
Extract RECON_dE Result Template Infogix EXTRACT 111915 11:24 AM RECON_dE DATAWARE_ENTITY FAILED
Extract RECOMN_dE Result Catalog EXTRACT 1171915 11:34 AM RECON_dE DATAWARE_ENTITY FAILED
Extract RECON_dE Control Data EXTRACT 1171915 11:34 AM RECIOM_dE DATAWARE_ENTITY FAILED
Page 1of2
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View Unresolved Report

Unresolved Report displays the details of all the failed
processes. To view Unresolved Report, complete the

following steps:
1. Navigate to root ->Infogix -> Admin -> ProcessMonitoring -> Reports.

2. Right-click Unresolved Report and select Run.

HMINFOC A Ubrary Quicklnks  Views Mamage. Create admin | Log Ovt Q

Folders Repository rt By Name Modifiad Date

e tee Copy  Cw Detete

Unresolved Report appears and displays the details such as process name
and type, entity name and type, starttime and the process status.
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i INFOGIX

MNovember 20, 2015

Unresolved Report a7
Process Name Process Type Start Time Entity Name Entity Type Status
Exfract Test1_CE Result Template Infogix EXTRACT 111015 12:24 &AM Testl_CE DATAWARE ENTITY FAILED
Exfract Test1_CE Result Templats Infopix EXTRACT 1110015 12:24 &AM Testi_CE DATAWARE_ENTITY FAILED
Report event re12 REPORT 1171315 4:05 &AM rel2 REPORT_EWENT FAILED
Extract EMP_NCA/MG Control Data EXTRACT 1116/15 4:07 AM EMP_NOV1E DATAWARE _ENTITY FAILED
Test Assure Source System TEST 11711815 5:12 AMDEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System Assure event TEST 1171815 5:18 AM Assure SOURCE_SYSTEM FAILED
Exfract EMP_DATA Result Catalog EXTRACT 11711615 4:44 PM EMP_DATA DATAWARE_ENTITY FAILED
Extract EMP_DATA Controd Data EXTRACT 11716815 4:44 PM EMP_DATA DATAWARE_ENTITY FAILED
Extract CE_Acssure Control Data EXTRACT 111715 2:23 AM CE_Aszure DATAWARE ENTITY FAILED
Extract CE_Acssure Controd Data EXTRACT 1111715 5:54 &AM CE_Assurs DATAWARE _ENTITY FAILED
Exfract DATACHECE_DE_MNCN10 Control EXTRACT 11711715 2:25 PMDATACHECK,_DE_MOW DATAWARE ENTITY FAILED
Test Assure Source System TEST 1111715 2:40 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System TEST 1111715 4:27 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Azsure Sgurce Sysiem TEST 1117115 4:20 PMDEFAULT_ASZURE &  SOURCE_SYSTEM FAILED
Test Assure Source System TEST 11711715 4:31 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System TEST 111715 5:41 PMDEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System TEST 1111715 11:22 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Extract EMP_Recruit Cantrol Data EXTRACT 111715 11:48 PM EMP_Recruit DATAWARE_ENTITY FAILED
Test Assure Source System TEST 11713115 2:60 PMDEFAULT_ASSURE S  SOURCE SYSTEM FAILED
Test Assure Source System TEST 1171315 2:50 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Scurce System TEST 1171315 3:13 PMDEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System TEST 1171315 3:20 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Test Assure Source System TEST 1171815 3:25 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Extract RECOM_dE Recon Task Repont EXTRACT 111315 3:51 PM RECOM_dE DATAWARE _ENTITY FAILED
Extract RECON_dE Control Data EXTRACT 1171315 3:51 PM RECON_dE DATAWARE ENTITY FAILED
Test Assure Source System TEST 11/18/15 10:03 PM DEFAULT_ASSURE_S SOURCE_SYSTEM FAILED
Extract RECON_dE Match St Audit Report EXTRACT 11718115 11:34 &AM RECCN_dE DATAWARE_ENTITY FAILED
Extract RECON_dE Match St Audit Report EXTRACT 11/118/15 11:34 &AM RECCN_dE DATAWARE_ENTITY FAILED
Extract RECOM_dE Recon Task Repont EXTRACT 1119115 11:24 AM RECOM_dE DATAWARE ENTITY FAILED
Extract RECON_dE Recon Task Repont EXTRACT 1118115 11:34 AM RECCN_dE DATAWARE _ENTITY FAILED
Extract RECON_dE Result Temgplate Chetna EXTRACT 11/18/15 11:34 AM RECON_dE DATAWARE ENTITY FAILED
Extract RECON_dE Result Template Chetna EXTRACT 11/118/15 11:34 &AM RECCN_dE DATAWARE_ENTITY FAILED
Extract RECON_dE Result Template Chetna EXTRACT 11718115 11:34 &AM RECCN_dE DATAWARE_ENTITY FAILED
Extract RECOM_dE Result Template Infogix EXTRACT 1119115 11:34 AM RECOM_dE DATAWARE _ENTITY FAILED
Extract RECON_dE Result Template Infogix EXTRACT 11118115 11:34 AM RECON_dE DATAWARE ENTITY FAILED
Page 1of2

processes.

Email Alert Feature

can receive

the emalil

You can set up email alert to designated email account for failed or unsolved
The Super user or Administrator
message by configuring the options in the User Preferences screen.

alert
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Get Started * | User Preferences *

k2 ) Reset Password i@ Help

User Preferences

Font Size Medium |~

Email Notification || Process Succeeded

|¥] Process Failed

You can also add mailing listin the Extract Event and Report Event screens so
that the recipient receives email alert for the completed or failed auto run
processes.
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Audit and Monitoring

Audit

An Administrator can view the default audit events if the Infogix Auditing
license is enabled.

All Audit Reports, including the archived Audit Reports, can now be viewed in
the Reports Repository. By default, audit data will be archived after 30 days and
archived audit data will be retained for 60 days. Audit data will be available for
a total of 90 days and then purged from the Repository.

There are two domains and two sets of reports created for accessing audit data:

1 Audit Domain and Audit Reports d Use these to view the current audit
data and they run against the active audit database.

1 Audit Archive Domain and Archived Audit Reports d Use these to run
reports on archived data and they run against the archive database.

The contents of both Domains and reports are identical ii they differ only in
the database tables that are accessed in each case.

The Ad Hoc View used to create Audit Reports can be opened in the Ad Hoc
editor to explore the audit data in real-time. These views can also be modified
in the Ad Hoc Editor to generate new reports to customize the auditing
requirements.

The following are the default Audit/Archived  Audit Reports:
1 Audit Report

1 Resource Execution Report

1 Repository Resources Report
1 Performance Crosstab Report
1 Performance Report

1 UserActivity Report

Audit Report

It displays the commonly audited events.
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